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Introduction

Dell Wyse Device Manager (WDM) is a software that manages all Dell Wyse thin and zero clients. WDM enables IT administrators to
perform the following functions with ease:

Software Imaging, updating, and configuring thin and zero client devices

Asset tracking of devices

Monitoring the health of devices

Managing the policies and network settings on devices

Remotely administering and shadowing the devices

WDM uses industry standard communication protocols and a component-based architecture to efficiently manage the devices on
your network. This guide provides information on the prerequisites to install WDM, and the steps to install and configure WDM in
your environment.

Installer Matrix

The following matrix describes the various combinations of Microsoft SQL Server, and Microsoft Windows Server that the installer
supports.

Windows

Server 2008 R2

SP1

RapportDB SQL Windows
Authentication
Enterprise Workgroup Distributed Enterprise Workgroup Distributed

Windows 2008 | Yes Yes Yes Yes Yes Yes
R2 SP1 + SQL
Express 2014
Windows 2008 | Yes Yes Yes Yes Yes Yes
R2 SP1 + SQL
Server 2008 R2
Windows 2008 | Yes Yes Yes Yes Yes Yes
R2 SP1+ SQL
Server 2008
Windows 2008 | Yes Yes Yes Yes Yes Yes
R2 SP1 + SQL
Server 2012

Windows

Server 2012




Windows
Server 2008 R2
SP1
RapportDB SQL Windows
Authentication
Windows 2012 | Yes Yes Yes Yes Yes Yes
+ SQL Express
2014
Windows 2012 | Yes Yes Yes Yes Yes Yes
+ SQL Server
2008 R2
Windows 2012 | Yes Yes Yes Yes Yes Yes
+ SQL Server
2008
Windows 2012 | Yes Yes Yes Yes Yes Yes
+ SQL Server
2012

Support Information

This section lists out the supported operating systems, the supported databases, and the supported thin client devices for WDM

version 5.7.2

Supported Operating Systems for WDM Server

Windows Server 2008 R2 Enterprise SP1
Windows Server 2012 Standard
Windows Server 2012 R2 Standard
Windows 7 Enterprise SP1(32-bit)
Windows 7 Enterprise SP1 (64-bit)

Supported Operating Systems to Upgrade all WDM
Components

Windows 2008 R2 SP1 Enterprise
Windows 2008 SP2 32-bit

Supported Databases

Microsoft SQL Server Express 2014 - English
Microsoft SQL Server 2008 R2 — English
Microsoft SQL Server 2008 Enterprise (32 bit)
Microsoft SQL Server 2012

Microsoft SQL Server 2012 Enterprise Edition for High
Availability.

Supported Thin Client Devices

Wyse ThinOS:
Wyse 3010 thin client with ThinOS
Wyse 3020 thin client with ThinOS
Wyse 5010 thin client with ThinOS
Wyse 5040 thin client with ThinOS
Wyse 3030 LT thin client with ThinOS
Wyse 5060 thin client with ThinOS
Wyse 7010 thin client with ThinOS

Wyse ThinOS PColP
Wyse 5040 AIO thin client with PColP




Wyse 5010 thin client with PColP
Wyse 3030 LT thin client with PColP
Wyse 5060 thin client with PColP

Wyse Enhanced Microsoft Windows Embedded Standard 7
(WES?) build 818 or later:

Wyse 5010 thin client with WES7
Wyse 5020 thin client with WES7
Wyse 7010 thin client with WES7
Wyse 7020 thin client with WES7
Wyse 7010 extended chassis thin client with WES7
Wyse 3030 thin client with WES7

Wyse Enhanced Microsoft Windows Embedded Standard 7p
(WES7p) build 850 or later:

Wyse 7010 thin client with WES7P

Wyse 7010 extended chassis thin client with WES7P

Wyse 5020 thin client with WES7P

Wyse 7020 thin client with WES7P

Wyse 7040 thin client with WES7P

Dell latitude E7270 mobile thin client

Wyse 5060 thin client with WES7P

Dell latitude 3460 mobile thin client
Wyse Enhanced Microsoft Windows Embedded 8 Standard
(64-bit) (WESS):

Wyse 5010 thin client with WE8S

Wyse 5020 thin client with WE8S

Wyse 7010 thin client with WE8S

Wyse 7020 thin client with WE8S

Windows 10 loT Enterprise (64—bit) (WIE10)
Wyse 5020 thin client with Win10 loT
Wyse 7020 thin client with Win10 loT
Wyse 7040 thin client with Win10 loT

Wyse Enhanced SUSE Linux Enterprise:

Wyse 5010 thin client with Linux
Wyse 5020 thin client with Linux
Wyse 7010 thin client with Linux
Wyse 7020 thin client with Linux

ThinOS Lite :
Wyse 3010 zero client for Citrix
Wyse 3020 zero client for Citrix
Wyse 5010 zero client for Citrix
Wyse 3010 thin client with Linux

ThreadX/View Zero Client:
Wyse 5030 zero client




Wyse 7030 zero client
Wyse 5050 AlO zero client with PColP

Thin Linux:
Wyse 3030 LT thin client with ThinLinux
Wyse 7020 thin client with ThinLinux
Wyse 5020 thin client with ThinLinux
Wyse 5060 thin client with ThinLinux

Supported EOL Dell Wyse Thin Client Platforms

Wyse Enhanced Microsoft Windows Embedded Standard 7
(WES?) build 818 or later:

C90LE7
ROOL7
ROOLE7
X90c7
X90m?7
Z90s7

Wyse Enhanced Microsoft Windows Embedded Standard 7P
(WES7P):

X90m7P
Z90s7P

Wyse Enhanced Microsoft Windows Embedded 8 Standard
(32-bit) (WESS) :

Wyse 5010 thin client with WE8S
Wyse 7010 thin client with WE8S
Z90D8E

Wyse Enhanced SUSE Linux Enterprise:
C50LE
R50L
R50LE
X50c
X50M
Z50S

ThinOS Lite:
CO0X
ROOX

ThreadX/ View Zero Client:
P20

Wyse ThinOS:
C10LE
R10L

Wyse Enhanced Microsoft Windows Embedded Standard
2009 (WES2009) build 641 or later:

CO0LEW
5010
ROOLW




ROOLEW
VOOLEW
X90CW
X90MW
7010
Z90SW

Localization Support

For the WDM Server, localization support is provided on Windows 2008 R2 SP1 Enterprise Edition and Windows 2012 Standard R2
for the following languages:

French

German

Spanish

Japanese

Simplified Chinese

Dell Wyse technical support

To access technical resources self-service portal, knowledge base, software downloads, registration, warranty extensions/ RMAs,
reference manuals, and so on, visit www.dell.com/wyse/support . For Customer Support, visit www.dell.com/support/
contents/us/en/19/article/Contact-Information/International-Support-Services/international-contact-center ?ref=contactus , and
phone numbers for Basic and Pro Support are available at www.dell.com/supportcontacts .

NOTE: Before proceeding, verify if your product has a Dell service tag. For Dell service tagged products, go to www.dell.com/
support/contents/us/en/19/article/Product-Support/Dell-Subsidiaries/wyse for more information.

Related documentation and services

Fact sheets containing features of hardware products are available on the Dell Wyse website. Go to http://www.dell.com/wyse and
select your hardware product to locate and download the Fact Sheet.

To get support for your Wyse product, check your product Service Tag or serial number.

For Dell service tagged products, find knowledge base articles and drivers on the Dell Wyse product pages.

For Non-Dell Service Tagged Products, find all the support needed by accessing the Wyse support domain.

Dell Wyse online community

Dell Wyse maintains an online community where users of our products can seek and exchange information about user forums. Visit
the Dell Wyse online community forums at: en.community.dell.com/techcenter/enterprise-client/wyse_general_forum/.

®
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Prerequisites

This section lists the prerequisites, the hardware, and software requirements that you must complete to prepare your environment to
install and configure WDM. This section consists of :

Pre-installation checklist
Hardware requirements

Software requirements
Communication port requirements
Upgrade requirements

Requirements for managing PColP devices

Pre-installation Checklist

Before you begin installing WDM, ensure that you meet the following requirements:

The server on which you install WDM should be dedicated to WDM services and should not be performing additional functions.
For example, the server should not be functioning as a Domain Controller, Backup Controller, Mail Server, Production Web Server,
DHCP Server, MSMQ Server, or Application Server.

Install a supported operating system on the server on which you install WDM. For more information, see Support Information.

Ensure that no other applications that require IIS are running on the system on which you are installing WDM.

Ensure that all required communication ports are available and open for communication between servers, routers, and switches.
For more information, see Communication Port Requirements.

Ensure that you have access to your operating system CD-ROM and your Microsoft Windows system files during your
installation. The WDM installer checks the system for all the software requirements. If any software is not installed, the installer
prompts you to install the required software. Therefore, you must have access to your operating system CD-ROM or the network
location to access the Microsoft Windows system files.

Install Adobe Acrobat reader to read the End User License Agreement (EULA) and the Installation Guide.

The server must be installed with ThreadX 5x components in Windows 2012 and above.

:



Hardware Requirements

The system on which you install WDM should meet or exceed the minimum system requirements and depends on the operating
system you install. The actual free space required depends on the number and size of the packages you register, and also on the
number of devices you will be managing.

Server Hardware Requirements for 32-bit OS

Category Minimum Requirements Recommended Configuration
CPU 2.5 GHz Dual core Intel or AMD Quad Core Intel or AMD
RAM 4GB 4GB

In case of a Virtual Machine, it should be 2
GB initially allocated

Minimum Free Space 40 GB 40 GB

Server Hardware Requirements for 64-bit OS

Category Minimum Requirements Recommended Configuration
CPU 2.5 GHz Dual core Intel or AMD Quad Core Intel or AMD

RAM 6 GB 8 GB

Minimum Free Space 40 GB 40 GB

Communication Port Requirements

WDM software components require certain communication ports to remain open on your servers, routers, and switches. For
example, WDM relies on the HTTP/HTTPS communications ports for operations initiated by WDM and pushed to devices.

Push operations include:

Issuing quick device commands such as Refresh Device Information, Reboot, Change Device or Network Information, Get Device
Configuration, and so on.

Distributing packages at a specific time.

Typically, port 80 is the default HTTP port and port 443 is the default HTTPS port. If either of these ports are closed, WDM cannot
push updates or quick commands to devices.

Communication Ports

WDM Component Protocol and Corresponding | Port Function
Ports
GUI HTTP 80 Communicate with the Web

Service and Standard Service.

:



WDM Component Protocol and Corresponding | Port Function
Ports
280
FTP 21 Register new packages into
the Master Software
Repository.
OLE DB 1433 (default) Communicate with the WDM
Can be configured during database.
installation.
VNC 5800 Remote shadows devices.
5900
Web Service HTTP 80 Communicates with the Web
Agent, GUI, and Standard
280 .
Service.
HTTPS 443 Secure Communication with
8443 the Web Agent, GUI, and
Standard Service.
OLE DB 1433 (default) Can be Communicate with the WDM
configured during installation Database.
Web Agent HTTP 80 Communication with the Web
Service.
280
FTP 21 Read and write files to the
master and remote software
repositories.
DHCP Proxy and TFTP OLE DB 1433 (default) Can be Communicate with the WDM
Services configured during installation database.
HTTP 8008 Communicate with the GUI
and Web Service.
DHCP Proxy and TFTP DHCP 67 Process UDP requests from
Services and PXE 68 PXE-enabled devices to the
Standard Service.
40M
TFTP 69 Download bootable image to
enable management
processing.
HTTP 80 Communicate with the Web
Service regarding actions and
status of current task.
FTP 21 Download and upload files to

the master and remote
software repositories.
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WDM Component Protocol and Corresponding | Port Function
Ports
DHCP Proxy and TFTP UDP 44956 Discover devices using subnet
Services and legacy support 44957 directed broadcasts that have
for older WDM agents older WDM Agents (5.0.0.x
and earlier) installed.
TCP 44955 Discover devices using IP
Range Walking. Upgrade
devices that have an older
WDM Agent (5.0.0.x and
earlier) installed.
ThreadX 4.x Manager Service | TCP 9880 Communicate with ThreadX
4.x devices.
50000
ThreadX 5.x Manager Service | TCP 49159 Communicate with ThreadX
9.x devices.
5172

% NOTE: Both the
communication ports
has to be added to
firewall Inbound rules. If
required, 49159 port
number can be
customized. The default
port 49159 is
customized, this needs
to be manually added.

Requirements for Managing PColP Devices

PColP devices that run the ThreadX firmware require a DNS Service Location (SRV) resource record to perform the following

actions:

Partial Check-In (heartbeat) — The device performs a heartbeat check-in every hour.

Firmware Download Completion Status —

The firmware upload is initiated by the server and the download completion is initiated by the device using the DNS SRV record.

ThreadX 4.x:

Configure FTP if you intend to use the firmware upgrade feature for PColP (ThreadX 4.x) devices. You must enable this in the
Software Repository. For more information on enabling FTP in the Software Repository, see the Dell Wyse Device Manager

Administrator’s Guide.
ThreadX 5.x:

Configure CIFS if you intend to use the firmware upgrade feature for PColP (ThreadX 5.x) devices. You must enable this in the
Software Repository. For more information on enabling CIFS in the Software Repository, see the Dell Wyse Device Manager

Administrator’s Guide
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Checklist to Install WDM Enterprise Edition Only

If you are installing WDM Enterprise Edition only, then ensure the following:

Obtain and have access to your WDM Enterprise Sales Key or Enterprise Evaluation Key that you use during installation.

Install the supported version of SQL Server. The WDM installer provides Microsoft SQL Express 2014 as the default option, but
you can choose another supported version of SQL Server.

You must install FTP services and it should be active to use FTP for Dell Wyse PColP (ThreadX 4.x) devices.
You must install CIFS services and it should be active to use CIFS for Dell Wyse PColP (ThreadX 5.x) devices.

NOTE:

If you plan to use PColP (Thread X), create and configure a DNS Service Location (SRV) resource record. For more
information, see Configuring L.oad Balancing for ThreadX 4.x Devices and Configuring Load Balancing for ThreadX 5.x Devices




3

Installing Dell Wyse Device Manager (WDM)

This section guides you through the complete WDM installation procedures. WDM consists of the following components:

Database
Management Server
Software Repository
Other Services

Web Ul

You can install all the components on the same system or you can have a distributed setup where each component is installed on
different systems.

You can install WDM in two flavours:

% NOTE:

6

Enterprise Edition —

This edition needs a specific license key and comes packaged with all the features of WDM. You can manage a very large number
of thin client devices using this edition. You can install this edition in a distributed environment and can install every component
on different systems.

Workgroup Edition —
This edition consists of a free license key and certain features of WDM are disabled. You can manage upto 10,000 thin client

devices using this edition. You must install all the components in the same system and you cannot have a distributed setup with
this edition.

% NOTE: Workgroup license needs to be activated.

To run the WDM Installer (Setup.exe), you must log in to the system as an Administrator.

You cannot install WDM on servers running other services such as the DNS, or DHCP, AD Domain Services or other
services that conflict with the WDM functionality and resources.

When you are installing the WDM database in a standalone or a distributed setup, and want to use an existing SQL
database, make sure that it is a full version of SQL Server and not SQL Server Express.

The Dell Community Forums supports the WDM Workgroup.

Threadx 5x management component is supported only in enterprise edition.



Installing the WDM Workgroup Edition

To install the Workgroup edition:

1.  Extract the contents of the WDM installer on the system where you want to install WDM.

2. Navigate to the folder where you have extracted the installer and run Setup.exe.

The Welcome screen is displayed.

WDM Installer - 5.7.2

(@ Install Guide

Welcome to Dell Wyse Device Manager

This wizard guides you through the installation of Dell Wysa Davice Manager 572

O your system. For more information and changes, see What's Mew in WEM 5

By installing or using the product, you agree to the following:
Dell Application oftware ELILA

Dell System Software EUILA

Third-party component licenses

Important Notice

Please see the Dell Wyse Device Manager Installation Guide to make sure that
your thin dient devices have the comrect versions of the WDM Agents to
communicate with the WDM server, You must reboot this computer to
complete the WDM installation process.

_ NEXT

Figure 1. WDM Installer 5.7.2 Screen

3. Click Next.

4. Select Workgroup as the License Type and click Next.

7
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(3 Install Guide

Figure 2. WDM Installer 5.7.2 (Workgroup) Screen

For Workgroup edition, the license key is provided within the Installer and you do not need to enter any details.

5. The components are all selected by default and you cannot de-select any component. Click Next.

18



J'IHDM Workgroup Edition Installer - 5.7.2

(o)

® Weicome Which components do you want to install?

@ Licersing

® Ccrmponen WOM Workgroup installs all the companents on the same compater or virtual
machire. You cannot deselect any component on this screen.

Figure 3. Components Screen

6. Inthe Configure Database screen, you can choose one of the following options:

Install New Database Server (Microsoft SQL Express 2014) — Select this option if you do not have any supported
version of Microsoft SQL Server installed on the system. Proceed to step 7.
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Figure 4. New Database Configuration

Use Existing Database Server (SQL Server Express or full) — Select this option if you have already installed a supported
version of Microsoft SQL Server on the system. Proceed to step 8. If you select this option, make sure that the existing
database server is on the same system where you are installing WDM Workgroup edition.

7. Provide the RapportDB database credentials. RapportDB is the WDM database instance that is created on SQL Server.

a. SQL Server Authentication is selected by default. Select Windows Authentication if you want to connect to the Rapport
Database using your Windows login credentials.
b. Enter Username, Password , and Confirm Password. The default username is rapport.

% NOTE: Password must match complexity rules of underlying Windows OS.

zo
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® Wealcoms

Configure Database
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. Authentication Method

# SOQL Server Authentication T Windows Authentication

Enter WDM Database credentials

8.

|
laiars
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() Install Guide

Username Password Cenfirm Password
rapport TTTTT YY) 'mlrlrl-l--i
Password provided for WDM datsbase user will be set for administrator wer "sa

Figure 5. New Database Configuration

If you have selected the second option in step 6, then provide the following details:

a. Enter Server Hostname, Port, Username, and Password. Port number is entered by default and the port number is 1433

g NOTE: Password must match complexity rules of underlying Windows OS.
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Weicome Configure Database
" INSTALL NEW DATABASE SERVER (| ficrosoft SO Express 2014
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Enter existing Database Server details
Server Hostname Port 5L Administrator FPassword
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venars gD Authentication Method
~TNEr SErices & SQL Server Authentication T Windows Authentication
o  Create new user
Enter WDM Database credentials € Use existing user
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Figure 6. Existing Database Configuration

9. Click Next. The Configure Software Repository Server screen is displayed.
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WDM Workgroup Edition Installer - 5.7.2

Configure Software Repository Server

* COMNFIGURE NEW REPOSITORY SERVER
" USE EXISTING REPOSITORY SERVER

Select Protocols Select Authentication Types
W HTTPS I Basic
W ETE F Windows (Recommended)

™ CIFS (Windows File Share)

Enter new credentials

& Create new user O Use existing user
Uzernarme Password Corfirm Pasoword
rapport

Figure 7. Configure Software Repository Server Screen

10. Enter the authentication details for the Software Repository:

a.

Configure New Repository Server — select this option if you want the installer to configure the repository server. You can
create a new user or use an existing user.

Use Existing Repository Server — select this option if you have already configured the Repository Server.

Enter Protocols — Select the protocol and settings to distribute software to the managed devices. HTTPS is selected by
default. You can also select FTP for ThreadX 4.x and CIFS for ThreadX 5.x.

Authentication Type — Windows is selected by default. You can also select Basic.

% NOTE: Basic authentication is required for Linux.

Username — Rapport is displayed by default. You can change this. If you select the Use existing Repository user option,

enter the user name of the existing user.
Password — Enter the password to access the repository.

g NOTE: Password must match complexity rules of underlying Windows OS.

g. Confirm Password — If you are creating a new user, enter the password again.
11. Click Next to install the other services.

12. DHCP Proxy is selected by default. Select the other services if required. Click Next.
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2
® Weicome Which services do you want to install?
® Licensing
® Components
® Database
@ Software Reposion
® Oiher Services W DHCP Proxy (for DHCP-based device discovery and PXE imaging)
BETImETlor [ TFTP Server (for PXE imaging)
e [T ThreadX Service (for managing P-class devices)
[T Threadx 5x Manager Service (for managing P-class devices, JRE 8 wall he
@ Install Guide e o et

Figure 8. Other Services Screen

Provide the installation path and click Next.
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Instaliaton

® Catabasze : 3 — i
cWProgram Files (x86)\Wyse\WDM

@ Sofnware Repositon,
& Ciher Services
® Cestination
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® Weicome Where do you want to install WDM?

Figure 9. Destination Screen

14. Select the certificate and import the same to start the installation.

NOTE: If you click the NEXT without selecting a certificate, the installer installs a self signed certificate. The
communications are encrypted, still the system is not completely secure. The certificate must be in the format

of _pfx file.

25



26

(o)

® Welcome

® [icersing

® Components

® Catabasze

@ Sofnware Repositon,
& Ciher Services

® Destination

® Corificate

() Install Guide

| WDM Workgroup Edition Installer - 5.7.2
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Note:

Pressing MEXT without selecting a certificate will install a self
signed certificate. Although communication will be encrypted,
the system will still not be completely secure.

In easze if user certificate fails to install, then self signed certificate
will be installed.

Figure 10. Certificate Screen
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o - i T
® Weicome Installation Summary
@® Licersin
Cormporents Licernze Type Workgroup
Datapase Components to install:
s Bl oy
® Software Repository Database
& :\:-.i'-E'f ﬂErf' Ces Marmagement EET‘- =r
® Destination Scitware Repository
@ Certificate Crther Sarvices
®nciall
Installation Path:
c\Program Files (BENWyse\W DN
Important Notice
Befare you start instaliation, please ersure the Windows Update is not updating
the OS or other software is not being instalied. Running Windows Updates at the
same time s WDM instaliation can cause conflicts and errors

Figure 11. Installation Summary Screen

The installation progress is displayed on the screen and after installation is complete, you are prompted to restart your system.
Restart the system for the system changes to take effect.

After installation, ensure that you will meet the following checklists:

Rapport folder should get created after installing WDM in C:\Inetpub\ftproot path.
WyseDeviceManager 5.7.2 WebUI icon will be created in the Desktop.

In IS, HApi Application should be created under Rapport HTTP Server.

In IS, MyWDM Application should be created under Rapport HTTP Server.

In IS, WebUI Application should be created under Rapport HTTP Server.

Installing the WDM Enterprise Edition

To install the Enterprise Edition:

1.  Extract the contents of the WDM installer on the system where you want to install WDM.
2. Navigate to the folder where you have extracted the installer and run Setup.exe.
If the server does not have .Net framework, then the .Net framework is installed automatically.

The Welcome screen is displayed.
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WOM Installer - 5.7.2

® Weicome Welcome to Dell Wyse Device Manager
_OMponants This wizard guides you through the installation of Dell Wyss Device Manager 5.7.2
atanae on your systern. For more information and changes, see What's New in WDM 5.7.2

By installing or using the product, you agree to the following:

Cartifeata Dell Application 5oftware ELILA
Dell System Software EULA
Third-party component licenses

Important Notice

Please see the Dell Wyse Device Manager Installation Guide to make sure that
your thin dient devices have the correct versions of the WDM Agents to
communicate with the WDM server, You must reboot this computer to
complete the WDM installation process.

Figure 12. WDM Installer 5.7.2 Screen

Click Next.
Select Enterprise as the License Type.
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n & single computer
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Figure 13. License Screen

a. If you have the WDM License key, select the | have WDM Enterprise License Key option and enter the license key in the
space provided.
b. If you do not have the License key, select the 30—days Enterprise Evaluation option.
The license key is entered by default. However, after the 30 days evaluation period, you need to obtain the license key and
add it to WDM. For more information on adding the license key, see the Dell Wyse Device Manager Administrator’s Guide.
5. Click Next.

Select the components you want to install and click Next.
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Figure 14. Component Screen

You can install all the components on the same system or each component on a different system.

NOTE: If you are installing the components separately on different systems, make sure you install the Database first.
If you do not install the database, you cannot install the remaining components.

In the Configure Database screen, you can choose one of the following options:

Install New Database Server (Microsoft SQL Express 2014) — Select this option if you do not have any supported

version of Microsoft SQL Server installed on the system. Proceed to step 8.
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Figure 15. New Database Screen

Use Existing Database Server (SQL Server Express or full ) — Select this option if you have already installed a supported
version of Microsoft SQL Server on the system. Proceed to step 9.

Provide the RapportDB database credentials. RapportDB is the WDM database instance that is created on SQL Server.

SQL Server Authentication is selected by default. Select Windows Authentication if you want to connect to the WDM

database (RapportDB) using your Windows login credentials.

g NOTE: Even if you choose Windows Authentication, the WDM installation always requires the SQL
Authentication to access the SQL database. In a standalone installation, after you complete the WDM database
installation, the WDM Installer takes care of assigning the Active Directory user to the database and the same

8.
a.

user is used for installing the WDM services.
b. Enter Username, Password, and Confirm Password. The default username is rapport.

ﬁ NOTE: Password must match complexity rules of underlying Windows OS.
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® Walcoms C'Dﬂﬁgure Database
®|irer
& F " INSTALL NEW DATABASE SERVER  (l\licroso® 5L Express 2014
Components ; }
 — & IUSE EXISTING DATABASE SERVER (SQL Server Express or full)
ToaTs REposeY Authentication Method
Mar e = SQL Server Authentication T Windows Authentication

* Create new user
T Use existing user

lJsername Password Confirm Password
rapport sesesNNN sesssNNe

Enter existing Database Server details

Server Hostnarme Port S0L Adminisirator Fassword

Figure 16. Existing Database Screen

If you have selected the second option in step 7, then provide the following details:

a. Server — Provide the hostname of the system on which you have installed Microsoft SQL Server.

b. Port — This is entered by default and the port number is 1433.

g NOTE: You can add five digit custom port for TCP/UDP in the range of 49152 to 65535.

c. Username — Enter the user name to connect to the existing database.
d. Password — Enter the password to access the database.

Click Next.
The Configure Software Repository Server screen is displayed.
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Figure 17. New Software Repository Screen

11. Enter the authentication details for the Software Repository:

a.

Configure New Repository Server — select this option if you want the installer to configure the repository server. You can
create a new user or use an existing user.

Use Existing Repository Server — select this option if you have already configured the Repository Server.

Enter Protocols — Select the protocol and settings to distribute software to the managed devices. HTTPS is selected by
default. You can also select FTP for ThreadX 4.x and CIFS for ThreadX 5.x.

Authentication Type — Windows is selected by default. You can also select Basic.

% NOTE: Basic authentication is required for Linux.

Username — Rapport is displayed by default. You can change this. If you select the Use existing Repository user option,

enter the user name of the existing user.
Password — Enter the password to access the repository.

g NOTE: Password must match complexity rules of underlying Windows OS.

g. Confirm Password — If you are creating a new user, enter the password again.
12. Enter the authentication details for the Software Repository:

a.

Configure New Repository Server — select this option if you want the installer to configure the repository server. You can
create a new user or use an existing user.
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Figure 18. New Software Repository Protocol Screen

b. Use Existing Repository Server — select this option if you have already configured the Repository Server.
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Figure 19. Existing Software Repository Screen

Enter Protocols — Select the protocol and settings to distribute software to the managed devices. HTTPS is selected by
default. You can also select FTP and CIFS.

Authentication Type — Windows is selected by default. You can also select Basic.

Username — Rapport is displayed by default. You can change this. If you select the Use Existing Repository User option,
enter the user name of the existing user.

Password — Enter the password to access the repository.

Confirm Password — If you are creating a new user, enter the password again.

13. Click Next to install the other services.
14. DHCP Proxy is selected by default. Select the other services if required. Click Next.
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Figure 20. Other Services Screen

% NOTE:

ThreadX 5.0 is supported on the operating system Windows Server 2012 and Windows Server 2012 R2 and above.

NOTE: Dell recommends you to install all the four services during WDM installation itself. If the WDM installation is
completed with only one service installed, then it is hot possible to install the remaining services. You must uninstall
and then re-install WDM by selecting the remaining services.

g NOTE:
- Select DHCP Proxy, to install the services for DHCP-based device discovery and PXE imaging.
Select TFTP Server, to install the services for PXE imaging.
Select ThreadX Service, to install the services for managing ThreadX (P- class) devices.

Select ThreadX 5.x Manager Service, to manage P-class services and to install JRE 8.
Provide the installation path and click Next.
The Destination screen is displayed.
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Figure 21. Destination Screen

16. Select the certificate and import the same to start the installation.
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% NOTE: If you click the NEXT without selecting a certificate, the installer installs a self signed certificate. The
communications are encrypted, still the system is not completely secure. The certificate must be in the format

of _pfx file.
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Pressing NEXT without selecting a certificate will install a self
signed certificate. Although communication will be encrypted,
the system will still not be completely secure.

In case if user certificate fails to install, then self signed certificate
will be installed.

BROWSE...

Figure 22. Certificate Screen

17. Click Next to begin the installation.

38



'WDM Enterprise Edition Installer - 5.7.2

Installation Summary
® [icersing

i T B e e Euvrmli int Y
Components License Type: Enterprize (30 days Evaluation)

Components to install:

[ B i im =y
® Software Repository Database
@ Ciher Services

laragement Server

® Destination

Software Repository

Orther Services

® Certificate

(@) Install Guide

®nciall
Installation Path:
c\Program Files (BENWyse\W DN
Important Notice
Befare you start instaliation, please ersure the Windows Update is not updating
the OS or other software is not being instalied. Running Windows Updates at the
same tirme 35 WDM instaliation can cause conflicts and errors

Figure 23. Installation Summary

The installation progress is displayed on the screen and after installation is complete, you are prompted to restart your system.
Restart the system for the system changes to take effect.

Installing the WDM on Cloud Environment

To install the Enterprise Edition:

1.
2.

Extract the contents of the WDM installer on the system where you want to install WDM.

Navigate to the folder where you have extracted the installer and run Setup.exe.

If the server does not have .Net framework, then the .Net framework is installed automatically.

The Welcome screen is displayed.
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® Weicome Welcome to Dell Wyse Device Manager
_OMponants This wizard guides you through the installation of Dell Wyss Device Manager 5.7.2
atanae on your systern. For more information and changes, see What's New in WDM 5.7.2

By installing or using the product, you agree to the following:

Cartifeata Dell Application 5oftware ELILA
Dell System Software EULA
Third-party component licenses

Important Notice

Please see the Dell Wyse Device Manager Installation Guide to make sure that
your thin dient devices have the correct versions of the WDM Agents to
communicate with the WDM server, You must reboot this computer to
complete the WDM installation process.

Figure 24. Welcome Screen

Click Next.
Select Enterprise as the License Type.



WDM Installer - 5.7.2

® \Walcoms SE"EC? }-’OUF ”CEHSE t}‘pe

¥ ENTERPRISE

UatakEs Designed for large crganizations, supports thousands of clients, and

DIOVIGES 2QYaNCed MaNagement fealines.

Jiher ervices " | have WDM Enterprise License Key
Enter License Key here

Don't have a License Key?

I~ WORKGROUP
A free licerse ideal for small to medium sized businesses. All WDK

n & single computer

PR P
SoMponents are Ins

Figure 25. License Screen

a. If you have the WDM License key, select the | have WDM Enterprise License Key option and enter the license key in the
space provided.
b. If you do not have the License key, select the 30—days Enterprise Evaluation option.
The license key is entered by default. However, after the 30 days evaluation period, you need to obtain the license key and
add it to WDM. For more information on adding the license key, see the Dell Wyse Device Manager Administrator’s Guide.
5. Click Next.

Select the components you want to install and click Next.
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Figure 26. Components Screen

You can install all the components on the same system or each component on a different system.

NOTE: If you are installing the components separately on different systems, make sure you install the Database first.
If you do not install the database, you cannot install the remaining components.

In the Configure Database screen, you can choose one of the following options:

Install New Database Server (Microsoft SQL Express 2014) — Select this option if you do not have any supported

version of Microsoft SQL Server installed on the system. Proceed to step 8.
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Figure 27. New Database Server Screen

Use Existing Database Server (SQL Server Express or full ) — Select this option if you have already installed a supported
version of Microsoft SQL Server on the system. Proceed to step 9.

8. Provide the RapportDB database credentials. RapportDB is the WDM database instance that is created on SQL Server.

a. SQL Server Authentication is selected by default. Select Windows Authentication if you want to connect to the WDM
database (RapportDB) using your Windows login credentials.

% NOTE: Even if you choose Windows Authentication, the WDM installation always requires the SQL
Authentication to access the SQL database. In a standalone installation, after you complete the WDM database
installation, the WDM Installer takes care of assigning the Active Directory user to the database and the same
user is used for installing the WDM services.

b. Enter Username, Password, and Confirm Password. The default username is rapport.
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Figure 28. Existing Database Screen

If you have selected the second option in step 7, then provide the following details:

a. Server — Provide the hostname of the system on which you have installed Microsoft SQL Server.

b. Port — This is entered by default and the port number is 1433.

NOTE: You can use user dynamic port for TCP/UDP in the range of 49152 to 65535 while installing WDM on

cloud environment.
c. Username — Enter the user name to connect to the existing database.
d. Password — Enter the password to access the database.
Click Next. The Configure Software Repository Server screen is displayed.



(o)

® Welcome
® Licensing
® Componerts
® Catabase

W O L

(@) Install Guide

® Software Repositon y

'WDM Enterprise Edition Installer - 5.7.2

Configure Software Repository Server

* COMNFIGURE NEW REPOSITORY SERVER
" USE EXISTING REPOSITORY SERVER

Select Protocols Select Authentication Types
W HTTPS I Basic
V¥ [ETF) k¢ Windows (Recommended)

™ CIFS (Windows File Share)

Enter new credentials

& Create new user O Use existing user
Uzernarme Password Corfirm Pasoword
rapport

o “

Figure 29. Software Repository Screen

1. Enter the authentication details for the Software Repository:

a.

Configure New Repository Server — select this option if you want the installer to configure the repository server. You can
create a new user or use an existing user.

b. Use Existing Repository Server — select this option if you have already configured the Repository Server.
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Enter Protocols — Select the protocol and settings to distribute software to the managed devices. HTTPS is selected by
default. You can also select FTP and CIFS.

Authentication Type — Windows is selected by default. You can also select Basic.

Username — Rapport is displayed by default. You can change this. If you select the Use Existing Repository User option,
enter the user name of the existing user.

Password — Enter the password to access the repository.

Confirm Password — If you are creating a new user, enter the password again.

12. Click Next to install the other services.
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If you are working on the AWS cloud environment, the following screen is displayed. Click Next to continue.
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% NOTE: ThreadX 5.0 is available only for Windows Sever 2012 , Windows Server 2012 R2 and above.

13. Provide the destination path and click Next. The destination screen is displayed.
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Figure 32. Destination Screen

14. Select the certificate and import the same to start the installation.

NOTE: If you click the NEXT without selecting a certificate, the installer installs a self signed certificate. The

communications are encrypted, still the system is not completely secure. The certificate must be of in the format

of .pfx file.
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The installation progress is displayed on the screen and after installation is complete, you are prompted to restart your system.

Installing WDM in a Distributed Setup

You can split the WDM components and install them on different systems. This setup is called a distributed setup of WDM. Ideally

you can split the components as follows:

WDM Database

WDM Management Server, WDM Management Console, and Other Services
WDM Software Repository

Web Ul

You can also have multiple instances of WDM Management Server and Other Services installed on different systems to enable load

balancing. For more information, see Configuring the Load Balancing Feature.

Installing WDM in a distributed setup is most suitable in a large enterprise where you are managing a large number of devices. This

section describes in detail the following:

Installing the WDM Database.

Installing Management Server and Web Ul

Installing the Software Repository.
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Installing the WDM Database

Before you install the WDM database on a system or virtual machine (VM), make sure you have the supported version of Microsoft
SQL Server installed on the system. If you do not have SQL Server on the system, you can choose to install Microsoft SQL Express
2014 that comes packaged with the WDM installer.

NOTE:
If you are installing the WDM database on an existing SQL Server database, make sure that port 1433 is available on the
system.

To install the WDM database, you must select Database on the Components screen, and then continue with the Installation process.

To install the WDM database:

1.
2.

10.
M.

Extract the contents of the WDM installer on the system where you want to install WDM.
Navigate to the folder where you have extracted the installer and run Setup .exe.

The Welcome screen is displayed.

Click Next.

Select Enterprise as the License Type.

a. If you have the WDM License key, select the | have WDM Enterprise License Key option and enter the license key in the
space provided.

b. If you do not have the License key, select the 30—days Enterprise Evaluation option.
The license key is entered by default. However, after the 30 days evaluation period, you need to obtain the license key and
add it to WDM. For more information on adding the license key, see the Dell Wyse Device Manager Administrator’s Guide.
Click Next.
The Components screen is displayed.
Select only the Database component.
In the Configure Database screen, you can choose one of the following options:

Install New Database Server (Microsoft SQL Express 2014) — Select this option if you do not have any supported
version of Microsoft SQL Server installed on the system. Proceed to step 8.

Use Existing Database Server (SQL Server Express or full ) — Select this option if you have already installed a supported
version of Microsoft SQL Server on the system. Proceed to step 9.

Provide the RapportDB database credentials. RapportDB is the WDM database instance that is created on SQL Server.

a. SQL Server Authentication is selected by default. Select Windows Authentication if you want to connect to the WDM
Database (RapportDB) using your Windows login credentials.

NOTE: If a custom Active directory user is required to be added post installation of Database then manually add
the Custom user in to the database and provide required Security rights. Later install Remaining components.

b. Username — The default username is rapport. You can retain the default or change the user name.

c. Password — Enter the password to connect to the database.

d. Confirm Password — If you are creating a new user, enter the password again.

If you have selected the second option in step 7, then provide the following details:

a. Server — Provide the hostname of the system on which you have installed Microsoft SQL Server.

b. Port — This is entered by default and the port number is 1433.

NOTE: You can add five digit custom port and also use dynamic port while installing WDM database. The
dynamic port rage for TCP/UDP is 49152 to 65535.

c. Username — Enter the user name to connect to the existing database.

d. Password — Enter the password to access the database.

e. Click Next.

Provide the installation path and click Next. The summary screen is displayed.

Click Next to begin the installation.

For Manual Installation of WDM Database using Scripts, see Manual installation of WDM database using scripts
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The installation progress is displayed on the screen and after installation is complete, you are prompted to restart your system.

Restart the system for the system changes to take effect.

Installing Management Server/Other Services/Management Console/ Web Ul

You can install the Management Server, Other Services, Management Console, and Web Ul on the same system or on different
systems.

To install these components:

1. Extract the contents of the WDM installer on the system where you want to install the WDM components.
2. Navigate to the folder where you have extracted the installer and run Setup .exe.
The Welcome screen is displayed.
3. Click Next.
4. Select Enterprise as the License Type.

a. If you have the WDM License key, select the | have WDM Enterprise License Key option and enter the license key in the
space provided.
b. If you do not have the License key, select the 30—days Enterprise Evaluation option.

The license key is entered by default. However, after the 30 days evaluation period, you need to obtain the license key and
re-install WDM.
5. Click Next.
The Components screen is displayed.

6. Select Management Server, Other Services, Management Console, and Web UI. If you are installing each of these
components on separate system, you can select them one by one after following steps 1to 5 given above.

7. Click Next to specify the WDM Database details.
8. Inthe Configure Database screen specify the following details:

a. Select the Authentication Method. SQL Server Authentication is selected by default. Select Windows Authentication if
you want to connect to the WDM Database (RapportDB) using your Windows login credentials.

b. If the WDM database is created on SQL Server, then provide only the server name. If the WDM database is created on SQL
Server Express, then provide the server name and the database instance name. For example, TESTVMMN\RapportDB.

c. Enter the user name and the password to access the WDM Database.
d. Click Next.

9. In the Services screen, only the DHCP Proxy service is enabled and selected by default. You can select the other options and
click Next.

10. Provide the installation path and click Next. The summary screen is displayed with the components you have selected.
1. Select the certificate and import the same and click Next.

The summary screen is displayed with the components you have selected.
12. Click Next to begin the installation.

The installation progress is displayed on the screen and after installation is complete, you are prompted to restart your system.
Restart the system for the system changes to take effect.

ﬁ NOTE: In distributed environment, Web Ul cannot be installed on a multiple console.

Installing the Software Repository

The Software Repository is another important component of WDM . The packages to be deployed on the client systems are saved
and stored in the software repository. Before you install the Software Repository, make sure you have installed and configured the
WDM database.

To install the software repository:

1. Extract the contents of the WDM installer on the system where you want to install WDM.
2. Navigate to the folder where you have extracted the installer and run Setup .exe.
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The Welcome screen is displayed.
3. Click Next.
4. Select Enterprise as the License Type.

a. If you have the WDM License key, select the | have WDM Enterprise License Key option and enter the license key in the
space provided.
b. If you do not have the License key, select the 30—days Enterprise Evaluation option.
The license key is entered by default. However, after the 30 days evaluation period, you need to obtain the license key and
re-install WDM.
5. Click Next.

The Components screen is displayed.

6. Select only the Software Repository component and click Next to specify the WDM Database details.

7. In the Configure Database screen specify the following details:

a.

b.

Select the Authentication Method. SQL Server Authentication is selected by default. Select Windows Authentication if
you want to connect to the WDM Database (RapportDB) using your Windows login credentials.

If the WDM database is created on SQL Server, then provide only the server name. If the WDM database is created on SQL
Server Express, then provide the server name and the database instance name. For example, TESTVM1\RapportDB.

Enter the user name and the password to access the WDM Database.

Click Next.

The Configure Software Repository Server screen is displayed.

8. Enter the authentication details for the Software Repository:

a.

b.
C.

g.
h.

Configure New Repository Server — select this option if you want the installer to configure the repository server. You can
create a new user or use an existing user.

Use Existing Repository Server — select this option if you have already configured the repository server.

Select Protocols — Select the protocol and settings to distribute software to the managed devices. HTTPS is selected by
default. You can also select FTP and CIFS.

Authentication Type — Windows is selected by default. You can also select Basic.

Username — Rapport is displayed by default. You can change this. If you select the Use existing user option, enter the
user name of the existing WDM database user.

Password — Enter the password to connect to the database.

Confirm Password — If you are creating a new user, enter the password again.

Click Next.

9. Provide the installation path and click Next. The summary screen is displayed.

10. Select the Certificate and import the same and click Next.

% NOTE: Same certificate should be used while installing the management server.

The summary screen is displayed with the components you have selected.

1. Click Next to begin the installation.

The installation progress is displayed on the screen and after installation is complete, you are prompted to restart your system.
Restart the system for the system changes to take effect.

GUID-CIF6041B-968F-444C-8497-E5CAED36BOBF
Upgrading WDM

The current version of WDM supports an upgrade from WDM version 5.7/5.7.1. You cannot upgrade from any other version. If you are
running an older version of WDM, you must first upgrade to version 5.7/5.7.1 and then upgrade to the latest version.

NOTE: After you upgrade to WDM version 5.7.2, you must upgrade all devices with the latest Agents packages available
to make sure your devices can be managed using WDM. For more information, see the WDM 5.7.2 Release Notes.

To upgrade to WDM version 5.7.2:

1. Extract the contents of the WDM installer on the system where you have installed WDM version 5.7/5.7.1.
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2. Navigate to the folder where you have extracted the installer and run Setup.exe.

The Welcome screen is displayed.

3. Click Next. The Upgrade Information screen is displayed.
WD Inskaller - 5.7.2
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® Upgrade
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Figure 35. Component Information

4.  Click Next to continue. User Credentials screen is displayed. Enter the password.

- Important: The Password field is disabled for SQL Authentication. You are required to enter the password only for
Windows Authentication.

5. Click Next.

The Important Information screen is displayed.

6. Read the Important Information carefully and click Next.

The upgrade process begins.
7. After the upgrade process is complete, click Restart Now for the system changes to take effect before you start using WDM.

NOTE: ThreadX 5.x is installed automatically if ThreadX 4.x is already installed on the system with windows 2012 and
above versions.

Configuring Secure Communications

Configuring Secure Communication using SSL:

There are different ways to install SSL in IIS 6.0 and IS 7.0. The procedures to configure SSL in IIS 6.0 and IIS 7.0 are given below.
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Configure SSL in IIS 7.0 on Windows Server 2008 R2

To configure SSL in IIS 7.0:

1
2.

Download SelfSSL7 utility from the link SelfSSL.exe.
Call the utility SelfSSL7.exe with the below mentioned parameters:

SelfSSL7.exe /Q /N cn=Certificate Name /I /S Web Site Name. e.g. SelfSSL7.exe /Q /N
cn="TestCert.TestLab.com" /I /S "Default Web Site"

Configuring Secure Communication Using Root Certificate Authority

Installing Root Certificate Authority in IIS 7 on Windows Server 2008 R2

Use the following guidelines:

In order to install the certificate, two steps need to be followed:

Install the certificate on Domain Controller server.
Install the certificate on WDM server.

Installing the Certificate on the Domain Controller Server

Use the following guidelines:

SN SR

10.

M.

12.

13.

14.

15.
6.

7.

18.

Go to the Server Manager.

In the tree pane select Roles->Add Roles.

In Add Roles wizard, select Server Roles from the tree pane.

In select Server Role window, check Active Directory Certificate Service from Roles.

Click Next->Next. Then in Role Services, check the options Certification Authority and Certificate Authority Web
Enrolment.

After checking the option Certificate Authority Web Enrolment, if IIS is not installed in the server, another window Add
Required Role Services window will appear.

On the above window, click Add Required Role Services button and click Next to invoke Specify Setup Type window.

In the above window depending on the requirement select either Enterprise or Standalone radio button and click Next to open
Specify CA Type window.

In Specify CA Type window, depending on the requirement select either Root CA or Subordinate CA radio button and click
Next to open Setup Private Key window.

In Setup Private Key window, depending on the requirement select either Create a new private key or Use existing private
key radio button and click Next to open Configure Cryptography for CA window.

In Configure Cryptography for CA window, depending on the requirement select the value for field Select a cryptography
service provider (CSP) from the combo box, provide the Key character length from the combo box, select the value for field
Select the Hash algorithm for signing certificate issued by this CA and either check or uncheck Allow administrator
interaction when the private key is accessed by the CA check box and click Next button to open Configure CA Name
window.

ﬁ NOTE: Common name of the certificate should match with WDM server's computer name.
In Configure CA Name window, provide the values for Common name for this CA and Distinguished name suffix fields and
click Next to open Set Validity Period window.

In the Set Validity Period window, select the validity period for the certificate generated for this CA and click Next to open
Configure Certificate Database window.

In Configure Certificate Database window, select the Certificate database location and Certificate database log location
and click Next to open Add Roles Wizard window for [IS.

Select the default values and click Next-> Install.
It will install the Active Directory Certificate Services, Web Server (IIS) and Remote Server Administration Tools.
Once the installation of certificate is over, go to the Internet Information Services Manager of the domain controller.

In the Server Manager tree pane, expand Roles, and then click Web Server (lIS)-> Internet Information Services (1IS)
Manager to open IS Manager window.
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19. In the tree pane select the Server and on the right pane double click Server Certificates.
20. In the right pane of Server Certificates, double click Create Domain Certificate... to begin creating a certificate.
21. Fillin the information requested in the Create Certificate window and click Next to open Online Certification Authority.

22. In Online Certification Authority, click select to Specify Online Certification Authority and provide a Friendly Name for the
same and click Finish.

23.  Now the installation of certificate in domain controller server is done, go to the installation of certificate on WDM server.

Installing the Certificate on the WDM Server

Use the following guidelines:

1. On the taskbar, click Start->Administrative Tools->Internet Information Services (IIS) Manager to open the 1IS Manager
window.
In the tree pane, click the Server and on the right pane double click Server Certificates to open Server Certificates Window.
Fill in the information requested in the Create Certificate window and click Next to open Online Certification Authority.

4.  In Online Certification Authority, click select to Specify Online Certification Authority and provide a Friendly Name for the
same and click Finish.

5. Now the installation of certificate in WDM server is done.

6.  After the installation of certificate, browse through Server ->Web Sites->Rapport HTTP Server and click Bindings... on right
most pane to open Site Bindings window.

7. In Site Bindings window, click Add to Add Site Binding

In Add Site Binding, select the recently created certificate from SSL Certificate combo box and click OK button.
9. Inorder to start only HTTPS communication, select SSL Settings under Server->Web Sites->Rapport HTTP Server.
10. In SSL Settings, select Require SSL check box and Apply the setting.

Installing Root Certificate Authority in IIS 7 on Windows Server 2012 R2
Use the following guidelines:

In order to install the certificate, two steps need to be followed:

— Install the certificate on Domain Controller server
— Install the certificate on WDM server

Install the certificate on Domain Controller server:
Use the following guidelines:

Go to the Server Manager.

In the Dashboard >> select option 2 Add Roles and features.

In Add Roles and Features wizard, select Installation Type as >> Role-based or feature-based installation.
In Server Selection >> Select a server from the server pool (By default local server will be selected).
Then in Server Role window, select Active Directory Certificate Services’ Role.

SRS IFNIIN S

Selecting Active Directory Certificate Services Role will launch the Add Role and Features Wizard” will auto launch with sub-
features>> Click on Add Features button.

Click Next->Next. Then in Features window, leave the default values as it is and click Next.
8. Thenin AD CS window appears and click Next button.
9. In Role Service window, select the options Certification Authority and Certificate Authority Web Enrolment.

10.  After selecting the option Certificate Authority Web Enrolment, if IIS is not installed in the server, another window Add Features
that are required for Certification Authority Web Enrollment sub-window will appear.

1. On the above window, click on Add Feature button and click Next to Confirmation window.
12. Then click on ‘Install’ button to install the AD Certificate role.

13.  In the Results window, Feature installation progress can be viewed.

14.  After Installation succeeds for AD Certificate Authority role, click on ‘Close’ button.

.



15.
6.
7.

18.

19.

20.

21.

22.

23.

24,

25.

26.

27.

28.
29.

Then in the Server Manager>> Dashboard console under notifications’ find the Post-deployment Configuration message.
In Post-deployment Configuration message click on link “Configure Active Directory Certificate Services on the local server”.

Then AD CS Configuration>> Credentials window will open get launched; provide the required appropriate credentials and click
on ‘Next’ button.

Then under Role Services>> select the options Certification Authority and Certificate Authority Web Enrolment and click ‘Next’
button.

Then in the Setup Type window, depending on the requirement select either Enterprise or Standalone radio button and click
Next to open CA Type window.

In CA Type window, depending on the requirement select either Root CA or Subordinate CA radio button and click Next to open
Private Key window.

In Private Key window, depending on the requirement select either Create a new private key or Use existing private key radio
button and click Next to open Configure Cryptography for CA window.

In Configure Cryptography for CA window,
depending on the requirement select the value for field Select a cryptographic service provider (CSP) from the combo drop
down box,
Provide the Key length from the next combo box
Select the value for field Select the Hash algorithm for signing certificate issued by this CA
and then either check or uncheck “Allow administrator interaction when the private key is accessed by the CA” check box

And click Next button to open Configure CA Name window. NOTE: Common name of the certificate should match with
WDM server's computer name.

In CA Name window, provide the values for Common name for this CA and Distinguished name suffix fields and click Next to
open Validity Period window.

In the Specify Validity Period window, select the validity period for the certificate generated for this CA and click Next to open
Certificate Database window.

In Certificate Database window, select the Certificate database location and Certificate database log location and click Next to
open Confirmation window.

Then in Confirmation window, click on Configure button which will launch the progress window.

Then in the Results window, Certification Authority and Certification Authority Web Enrollment Configuration succeeded
message will appear.

Click on Close button to finish the configuration of AD CS.
Now the installation of certificate in domain controller server is done, go to the installation of certificate on WDM server.

Installing the Certificate on the WDM Server:

Use the following guidelines:

1.

On the taskbar, click Start->Administrative Tools->Internet Information Services (lIS) Manager to open the IS Manager
window.

In the tree pane, click on the Server and on the right pane double click on Server Certificates to open Server Certificates
Window.

Click on Create Domain Certificate link on right most pane and fill in the information requested in the Create Certificate window
and click Next to open Online Certification Authority.

In Online Certification Authority, click select to Specify Online Certification Authority (created in your AD Controller machine or
in your setup) and provide a Friendly Name for the same and click Finish.

Now the installation of certificate in WDM server is done.

After the installation of certificate, browse through Server -> Sites->Rapport HTTP Server and click on Bindings... on right
most pane to open Site Bindings window.

In Site Bindings window, click Add to Add Site Binding

In Add Site Binding, select Type as HTTPS, and select Certificate Authority under IP Address, select the recently created
certificate from SSL Certificate combo drop down box and click OK button.

In order to start only HTTPS communication, select SSL Settings under Server->Web Sites->Rapport HT TP Server.
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In SSL Settings, select Require SSL check box and ‘Require’ radio button for Client certificate and Apply the settings.
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Uninstalling a Standalone Installation of WDM

If you have a standalone installation of WDM, where all the components are installed on the same system, then you can follow the
steps given below to uninstall WDM.

To uninstall WDM:

1. Click the start menu and select Control Panel.
2. Click Programs — Uninstall a program on the Control Panel screen.
3. Select WDM 5.7.2 from the program list and click Uninstall.
The Uninstallation Screen is displayed.
4. Click Next on the Welcome screen.
5. Enter the credentials to access the WDM database.

You need to specify the SQL Login ID and password for SQL Server or SQL Express depending on where you have installed the
WDM database.

If you specify the wrong credentials, the program displays the following message: Unable to connect to database. Make sure
you enter the correct credentials.

6. Click Next to begin the uninstallation process.

7. After the components are uninstalled you are prompted to restart your system. Click Restart Now to complete the uninstallation
process.

After the Uninstallation, ensure that you meet the following checklists :

WyseDeviceManager 5.7.2 WebUI icon should be removed from the Desktop.
In IS, HApi Application should be deleted under Rapport HTTP Server.

In IS, MyWDM Application should be deleted under Rapport HTTP Server.
In IS, WebUI Application should be deleted under Rapport HTTP Server.

Uninstalling WDM in a Distributed Setup

If you have installed WDM in a distributed setup, then you need to uninstall the components one by one on the systems where you
have installed them.

% NOTE: You must uninstall all the other components on the systems where you have installed them, before you uninstall
the WDM database.

To uninstall the WDM components:

1.  Log in to the system or systems where you have installed the Management Server, Management Console, Other Services,
Software Repository, and the Web Ul

2. Click the start menu and select Control Panel.
3. Click Programs — Uninstall a program on the Control Panel screen.
4. Select WDM 5.7.2 from the program list and click Uninstall.

The Uninstallation Screen is displayed.

.



Click Next on the Welcome screen.

Click Next to begin the uninstallation process.

Log in to the system where you have installed the WDM database.
Repeat steps 2 to 5.

© ® N o

Enter the credentials to access the WDM database.

You need to specify the SQL Login ID and password for SQL Server or SQL Express depending on where you have installed the
WDM database.

If you specify the wrong credentials, the program displays the following message: Unable to connect to database. Make sure
you enter the correct credentials.

10. Click Next to begin the uninstallation process.
11. After the database is uninstalled, restart the system when prompted.
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Configuring High Availability Database Clustering
for WDM

High-availability clusters (also known as HA clusters or failover clusters) are groups of computers that support server applications
that can be reliably utilized with a minimum down-time. They operate by harnessing redundant computers in groups or clusters that
provide continued service when system components fail.

If a server running a particular application crashes, then without clustering, the application is unavailable until the crashed server is
fixed. HA clustering remedies this situation by detecting hardware/software faults, and immediately restarting the application on
another system without requiring administrative intervention. This process is termed failover.

HA clusters usually use a heartbeat private network connection which is used to monitor the health and status of each node in the
cluster.

The most common size for a HA cluster is a two-node cluster.

QD

Virtual hostname for SQL Server
wdmdb.x2 Public
Metwork
Interface
Private Private
o Metwork Metwark 1::
° Interface Interface | o
s Quorum ~
= Folder/Server =
WDM SQL [Database 1 WDM SQL Database 2

wdmdbl x2 O wdmdp?2.x2

Shared Database Storage
Figure 36. WDM High Availability Database Clustering

This section provides the steps to configure high-availability (HA) database clustering for Dell Wyse Device Manager (WDM) version
5.0 and above.
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Components Required for Database Clustering

The high availability environment for WDM consists of the following components:

Primary Server or Primary Node — This is one of the four Virtual Machines (VMs) on which you need to install Microsoft SQL
Server 2012 database. This should have two network adapters, one configured for public and one configured for private.

Secondary Server or Secondary Node — This is the second VM and ensures high availability when the primary server fails. This
should also have two network adapters, one configured for public and one configured for private.

Server for the Quorum folder — This is the third of the four VMs and is needed to create the Quorum folder
WDM Server — This is the fourth VM on which you need to install WDM.

Pre-requisites for Database Clustering

Database clustering requires the following :

4 VVMware Virtual Machines (VMs) out of which 2 VVMs should contain 2 network adapters each.

Supported version of Microsoft SQL Server Database (standalone version). For more information on supported databases, see
Support Information.

NOTE: The steps for database clustering discussed in this guide are performed on Microsoft SQL Server 2012.
However database clustering is supported on other supported versions of SQL Server.

All the VMs should be connected to an Active Directory (AD) domain.

All the four VMs should have Windows Server 2008 R2 Enterprise installed on them.

% NOTE: You cannot use SQL Server Express for database clustering.

Configuring the Primary and Secondary VMs

After you create the VMs on the server, you must configure them to support clustering. You must configure both the primary and
the secondary nodes by following the steps given below.
To configure the primary and secondary VMs
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Launch the vSphere client on any system on the network and select the VM.

Right click and select Edit Settings. Click Add to add one more network adapter (also referred to as node).

In the Add Hardware screen, select Ethernet Adapter and click Next.

Select the Subnet from the Network label drop-down list and click Next.

Click Finish.

In the VM Properties screen, check that there are two nodes.

Launch the Network Connections screen from Control Panel - Network and Internet — Network Connections and rename
the network connections to Private and Public.

NOTE: There must be two subnets for two network cards i.e. one subnet for the Public network (PDB) and one
subnet for the Private network (PDB), and the same for the two network cards on the SDB server

Make sure that the Public Network option is first in order in the Advanced Settings window.

To launch the Advanced Settings window, press the Alt button to access the Advanced menu in the Network Connections
screen and select the Advanced Settings option.

In the Network Connections screen, select Public, right click and select Properties.
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1.

12.

13.

14.

15.

16.

17.
18.
19.

20.

In the Advanced Settings window, select IPv4 and click Properties.
Enter the IP address, Subnet mask, Default gateway and the Preferred DNS server. Click OK.
Repeat steps 10 and 11 for the Private network.

Make sure that the Private network contains only the IP address and Subnet mask. The Default Gateway or DNS Servers
should not be defined.

Make sure that the servers can communicate acoss this network so that the nodes can communicate with each other across
the network.

Launch the Server Manager from Start - Administrative Tools. Select Features.
Click Add Features to launch the Add Features wizard.
Select Failover Clustering and click Next.

Make sure that the Failover Clustering option appears in the Confirm Installation Selections screen. Click Install. The
installation progress is displayed.

After installation completes, check the installation results and click Close.

After the Failover Clustering installation is complete, reboot the server.

Validating a Configuration

After you install Failover Clustering, you must validate the configuration on the primary node. To validate the configuration:
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10.

n.

Launch the Server Manager of the primary node from Start - Administrative Tools.
Select Failover Cluster Manager under Features.

Click Validate a Configuration to launch the wizard.

Click Next to add the primary and secondary nodes.

Enter the hostname of the primary node.

Click Add to select the servers. The screen displays the following message while adding the servers: “The operation is taking
longer than expected”. You need to wait for a few minutes for the servers to be added.

After the servers are selected, they are displayed under Selected Servers. Click Next.

A multi-site cluster does not need to pass the storage validation . To skip the storage validation process click Run only the tests |
select and click Next.

In the Test Selection screen, uncheck the Storage option and click Next to continue.
The Confirmation screen is displayed.

Click Next to start running the validation tests on the primary and secondary nodes (in this case cluster1and cluster2). The
status of the validation tests are displayed on the screen.

View the validation summary and click Finish.

Creating a Cluster on the Primary Node

After you install and validate the Failover Cluster Manager feature on the primary node, you can create a cluster.

To create a cluster on the primary node:

1.
2.
3.

Launch Server Manager on the primary node, select Failover Cluster Manager under Features, and click Create a Cluster.
Click Next on the wizard.

Click Next to continue and in the Select Servers screen, enter the hostname of the primary node, and click Add to add the
server

Enter the name of the secondary node and click Add.

After the servers are added, click Next to continue. You are prompted to validate your cluster. Select No since your cluster is
validated.

Select the second option on the screen and click Next to continue.
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7. Provide a name for the cluster and an IP for administering the cluster. The name you provide is to administer the cluster. This
should not be the same as the name of the SQL Cluster resource that you will create later. Enter WINCLUSTER as the name of
the cluster and enter the IP address. Click Next to continue.

NOTE: This is also the computer name that you need to provide permission for the File Share Majority Quorum, that
is described later in this document. For more information, see Implementing a Node and File Share Majority Quorum.

8. Confirm and click Next.

The cluster forming progress is displayed on the screen. If you have performed all the steps correctly, then the cluster formation
is successful. If you see the yellow warning symbol on the screen, then it indicates that the cluster formation was successful,
but with warnings

9. Click View Report to view the warnings while forming the cluster. The report is displayed with warning messages highlighted in
yellow.

10. Ignore the warning messages and click Finish to complete the cluster formation process.

Implementing a Node and File Share Majority Quorum

A guorum is a design to handle the scenario when there is a problem with communication between sets of cluster nodes, so that two
servers do not try to simultaneously host a resource group and write to the same disk at the same time. By having this concept of
quorum, the cluster will force the cluster service to stop in one of the subsets of nodes to ensure that there is only one true owner
of a particular resource group. The Node and File Share Majority quorum configuration is usually used in multi-site clusters. This
configuration is used when there is an even number of nodes in the cluster, so it can be used interchangeably with the Node and
Disk Majority quorum mode. In this configuration every node gets 1 vote, and additionally 1 remote file share gets 1 vote.

To configure a Node and File Share Majority Quorum:

1. Select the VM identified for creation of the quorum folder, and create a folder called Quorum and share the folder location.
2. Right click on the Quorum folder and select Share with -> Specific people.
3. Inthe File Sharing window, select Everyone. Select the Read/Write permission and click Share.

The folder is shared as \\<Name of the VM>\Quorum.

You now need to change your quorum type. Launch the Server Manager on the primary node, and select Failover Cluster
Manager under Features.

>

Right click on your cluster and select More Actions - Configure Cluster Quorum Settings.

Select the Node and File Share Majority (for clusters with special configurations) option and click Next.
Enter the path of the shared folder that you have created on the third VM and click Next.

Confirm the shared folder location and click Next.
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The quorum settings for the cluster are successfully configured.
9. Click Finish to complete the process and view the quorum configuration for the cluster.

Installing .NET Framework on Primary and Secondary Nodes

Microsoft .NET Framework is a pre-requisite to install SQL Server Standalone 2012 (or any other supported version of SQL Server)
on the primary and secondary nodes.

To install the .NET Framework:

Launch Server Manager on the VMs you have identified for the primary and secondary nodes.

Click on Features under Server Manager to launch the Add Features Wizard and select .NET Framework 3.5.1 Features.
Click Next and you will prompted to install the required rol services and features to install .NET Framework 3.5.1 features.
Click Add Required Role Services. The option .NET Extensibility is selected by default. Click Next to continue.

Confirm the installation selections and click Install.

After the installation of the selected components is complete, the installation results are displayed.
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Click Close to complete the .NET Framework installation.

:



Installing SQL Server on Primary and Secondary Nodes

Installing SQL Server on both the nodes and configuring it to function in a cluster is an important step in the setup of a high
availability database cluster. This section provides the steps to install and configure SQL Server 2012 standalone on both the nodes.
If you want to install any of the supported versions of SQL Server, see the installation instructions provided by Microsoft.

To install a standalone version of SQL Server 2012 on the both the nodes:

—
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6.

7.

18.
19.

Launch the SQL Server 2012 installation media.

Click Installation and select New SQL Server stand-alone installation or add features to an existing installation.
Make sure that the Setup Support Rules does not display any failures. Click Next to continue.

Enter the Product key and click Next.

Check the product update and click Next.

Accept the license agreement and click Next.

Select the SQL Server Feature Installation option and click Next.

In the Feature Selection screen, select the Database Engine Services features and all the features under it.
Select the Management Tools — Basic feature and the feature under it. Click Next.

Make sure that the Installation Rules screen does not display any failures. Click Next.

In the Instance Configuration screen, make sure that the Default instance option is checked.

Click Next to view the Disk Space Requirements.

Click Next to view the Server Configuration.

Enter the domain credentials for server configuration and click Next.

In the Database Engine Configuration screen, select Mixed Mode and enter the SQL Administrator password and click Add
Current User.

Click Next on the Error Reporting window.
Click Next and make sure that the installation configuration rules does not display any failures.
Click Install to begin the installation process.

After the installation completes, the installation status is displayed. View the status and click Close to complete the installation.

NOTE: If you encounter the Windows Firewall Warning while installing SQL Server, you can ignore the warning and
continue with the installation. If required, you can add port 1433 to the SQL Server firewall exception.

Installing SQL Server Failover Cluster on Primary Node

After you complete installing SQL Server 2012 on both the primary and secondary nodes, you need to configure both the nodes to
support the failover clustering.

To install the SQL Server 2012 failover cluster on the primary node:

1.
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Launch the SQL 2012 Server Installation media.

Click Installation and select New SQL Server failover cluster installation.

Make sure that the Setup Support Rules screen does not display any failures. Click OK.
Enter the product key and click Next.

Accept the license terms and click Next.

Check the product updates and click Next.

.



10.
M.

12.
13.
4.

15.

6.
7.

18.
19.

20.

21.

22.
23.
24,
25.

Make sure that the Setup Support Rules screen does not display any failures or errors. You can ignore the warnings and click
Next.

Select the SQL Server Feature Installation option in the Setup Role screen and click Next.

Select all the options under Instance Features - Database Engine Services , and Shared Features - Client Tools
Connectivity on the Feature Selection screen. Click Next.

Make sure that the Feature Rules screen does not display any failures. Click Next.
In the Instance Configuration screen, enter the following details:

SQ@L Server Network Name — WDMCLUSTER

Named Instance — WDMCLUST

Instance ID - WDMCLUST

Click Next.
Check the Disk Space Requirements and click Next.
Leave the default settings on the Cluster Resource Group screen and click Next.

Since you have configured a File Share Majority clustering, you do not need to select any disk. Click Next on the Cluster Disk
Selection screen.

In the Cluster Network Configuration screen, enable IP4 and provide the IP address for the SQL Failover cluster and click
Next to proceed to the Server Configuration screen.

Enter the domain credentials for the SQL Server Agent and SQL Server Database Engine and click Next.

In the Database Engine Configuration screen, select the Mixed Mode (SQL Server authentication and Windows
authentication) option and enter the SQL Administrator password.

Click Add Current User to add the Administrator user and click Next.
You will be prompted to install a SQL Failover Cluster. Click Yes on the prompt.

Click the Data Directories tab on the Database Engine Configuration screen. In the location for the Data root directory, enter
\\<Name of the Quorum VM>\quorum. Click Next.

Check the Error Reporting screen and click Next. You can ignore the warnings.

Make sure that there are no failures in the Cluster Installation Rules screen. Click Next.

Click Install to begin the installation.

The Installation Progress screen displays the progress of installation. Click Next when the installation completes.

Click Close to complete the installation. The Failover Cluster Manager should be displayed in Server Manager under Features.

Post Clustering Procedure

This section discusses the various steps you need to perform after you complete the cluster setup. These steps enable your cluster
to function smoothly without any issues.

Follow the steps given below:

1.
2

e
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In both the cluster nodes, make sure that the SQL Server Services are started up with the domain credentials.

Launch the SQL Server Configuration Manager and select SQL Server Services > SQL Server. Right click and select
Properties.

Check the domain credentials and click OK.
Click the AlwaysOn High Availability tab on both the nodes and select the Enable AlwaysOn Availability Groups. Click OK.
Install the WDM database on VMs that you have identified as the primary and secondary nodes of the cluster.



6. Run the following script on the database:

Use RapportDB
GO
Update Install set ServerName='NEWCLUSTERO1l' where Module='Rapport4DB'

7. When you install the WDM components without the database, make sure you provide the name of the SQL Database Cluster
name in the Server IP Address field.

8. Create the same directory structure pointing to the database location both in the primary as well as the secondary node. For
example, if the database is present in C:\Program Files\WYSE\WDM\Database in the primary node, create the same
structure in the secondrary server as well.

9. Launch the SQL Server Management Studio on the primary node. Login with the default SQL user name and password.

10. Right-click on RapportDB database and select Properties.

11. Inthe Database Properties screen, change the Recovery Model to Full.

12. Right-click on the RapportDB and select Tasks - Backup to take a backup of the RapportDB.

13. Leave the defaults on the Backup Database screen and click OK.

14. Right-click on AlwaysOn High Availability in the Object Explorer and select New Availability Group Wizard.

156. Click Next on the New Availability Group Wizard screen.

16. Provide a name for the Availability group such as Rapport_cluster and click Next.

17. Select the database and click Next.

18. Click Add Replica and select the Automatic Failover (up to 2) and Synchronous commit (up to 3) check-boxes.
Repeat the step for the secondary node.

19. Click Next.

20. Select the Full option and specify the shared folder location as \\<Name of the Quorum Machine>\quorum. Click Next.

21. Make sure that the Validation screen does not display any failures.Click Next.

22. If you see any warnings on the screen, you can ignore them and proceed with the installation.

23. Click Finish to complete installing the New Availability Group.

24. The progress window displays the progress of the installation. Click Next when installation completes.

25. View the results and click Close.

26. The primary and secondary nodes are displayed on the SQL Server Management Studio.

27. Shutdown the secondary node and check to make sure that the primary node is running in the cluster.

28. Launch the SQL Server Management Studio on the primary node. Login with the default SQL user name and password.

29. Click the Security node, select Login, right-click and select New Login to create the Rapport user. This step is important for
WDM to function as you are creating the SQL Server Authentication user.

30. Select Server Roles, select the sysadmin check-box and click OK.
31. View the Rapport user on the SQL Server Management Studio.
32. Repeat steps 28 — 31 on the secondary node.

% NOTE: If there is a fail-over from the primary database to the secondary database, you must restart the WDM UI.

Running the HA Configuration Utility

WDM needs to connect to the cluster in order to function within the cluster and ensure that there is zero downtime.

The High Availability Configuration Utility is available after you install WDM on a separate node other than the primary and secondary
nodes.

1. Login to the system where you have installed WDM.
2. Launch the HAConfigureUtility from Start — All Programs — Dell Wyse Device Manager — Ultilities.
3. Enter the following details:

Configure Setup As — select Cluster from the drop-down list.

Database Name — this is displayed by default and cannot be edited.
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Database Server — Specify the hostname of the database cluster. For example, WDMCLUSTER.
Database User Name — Specify rapport as the database user.
Database Password — Specify the password of the rapport user.
4. Click Configure.
The connection details are displayed on the bottom pane of the utility.

Adding a License on WDM

WDM needs a license to function. The licensing code is generated based on the database. WDM is normally installed on a standalone
database and then moved to a cluster. Therefore, after your cluster setup is complete, you need to generate the license code again
for the cluster.

To add a license on WDM for the WDM server:

1. Launch Wyse Device Manager (WDM). The following error is displayed: “Application Function: Scopeltems_Expand: 13 Type
mismatch”.

2. Click OK and add the license from the WDM console.
3. Toinitiate failover, shutdown the database on the primary node and restart the WDM Console.
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Configuring Load Balancing

When you use WDM to manage thin client devices in a very large enterprise environment, a single WDM Management Server cannot
scale up to manage the large number of devices. There could be problems or delays in client check-ins, schedule execution, or real-
time command execution.

Load balancing helps resolve these problems to a great extent. In this setup, you can install and run multiple instances of WDM
Management Servers on different systems and configure the load balancing feature between them. WDM uses the Microsoft

Application Request Routing (ARR) for IIS 7 feature to perform load balancing between the management servers. This section
describes how to setup and configure load balancing.

Thin Clients

a4

N/l
f!?"";f

WDM instance 1 WDM instance 2
wdmserverl.x2 wdmserver2. x2
Figure 37. WDM Load Balancing Setup

Setting up the ARR Proxy Server

The Application Routing Request (ARR) Proxy server is the most important component of Load Balancing. This server receives the
requests from the thin client systems and routes them to the different WDM Management servers.
Before you set up the ARR Proxy server, you must make sure of the following:

The entire setup should be on Windows 2008 Server R2 or higher.
Install all the components of WDM on one server.

Install only the WDM Management Server and ThreadX 4.x service on another server.
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NOTE: You can set up the ARR Proxy Server and the WDM Management Servers across different subnets in the same
doamin.

Setting up the ARR Proxy Server consists of the following steps:

Installing IIS.
Installing the ARR Module.

Configuring the Application Pool Process for ARR.

Creating a Server Farm of WDM Management Servers.

Configuring SSL
Configuring Server Farm Properties for ARR.

Configuring Request Filtering
Setting up the Proxy FQDN in WDM Preferences.
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Installing Internet Information Services (lIS)

Install Windows 2008 Server R2 on any of the systems that you identify to be the ARR Proxy Server.
To install IIS:
1. Log in to the system as an administrator and launch the Server Manager.
2. Select Roles under Server Manager and click Add Roles on the right-hand pane.
The Add Roles Wizard is displayed.
3. Select Server Roles and check Web Server (IIS) and click Next.
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Select the following options:

Option |Sub-options

Common HTTP Features . Static Content

Default Document
HTTP Errors
Directory Browsing

Health and Diagnostics . HTTP Logging
Request Monitor
Logging Tools
Tracing
Management Tools Select all the sub-options.
B. Click Next to view the summary.
6. Click Install to install IIS.

Installing the ARR Module

You must install the Application Request Routing version 3.0 on the system you have identified to be the ARR Proxy Server. The
installer is available on the Microsoft download site at https://www.microsoft.com/en-us/download/details.aspx?id=47333.
Download the ARRv3_0.exe file and install it.

Configuring the Application Pool Process for ARR

All HTTP requests and responses for the content sites go through Application Request Routing. For this to function correctly you
must make sure that the worker process of the Default Web Site on ARR is always running.
To configure the application pool process:

1. Login to the ARR Proxy Server, and launch the IS manager.
2. Select Application Pools under the root node.
The right-hand pane displays DefaultAppPool as the application pool for the Default Web Site.
3. Select DefaultAppPool and click Edit Application Pool on the Action pane.
4. Select Advanced Settings to display the Advanced Settings window.


https://www.microsoft.com/en-us/download/details.aspx?id=47333
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5. Under Process Model change the value of Identity from LocalSystem to ApplicationPoolldentity.
6. Change the Idle Time-out (minutes) to O to disable the setting. Click OK to save the changes.

Creating a Server Farm of WDM Management Servers

To create and define a server farm:

1.  Log in to the ARR Proxy Server system and launch the IIS Manager.
2. Select Server Farms under the root node. This option is available only after you install the ARR Proxy module.
3. Right-click and select Create Server Farm from the menu.

The Create Server Farm screen is displayed.
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4. Enter a name for the server farm. For example, WDMServerFarm. Click Next to add the WDM Management servers.
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5. Type the host name of the WDM Server and click Add. You can add all the servers where you have installed the WDM
Management Server.

6. Click Finish to add all the servers to the farm.

After the servers are added and the server farm is created you are prompted with a message to rewrite the routing rules for all
requests to automatically come to the server farm.

7. Click Yes so that IIS manager can create a URL rewrite rule to route all incoming requests to this server farm.

GUID-821FA42D-B3CE-45E0-97EA-621DEO23882E
Configuring SSL

One of the features in ARR is SSL off-loading. This is a feature in which the communications between the clients and the ARR
Proxy Server are done via SSL, and the communications between the ARR Proxy Server and the WDM Management Servers are
done via clear text. By enabling this feature, you can help to maximize the server resources on the WDM Management Servers.
You first need to create the SSL Certificate on the ARR Proxy Server.

To create and configure the SSL Certificate:

Log in to the ARR Proxy Server and launch the IIS Manager.

Select the root node and open the Server Certificates page from the right-hand pane.
Click Create Domain Certificate on the Action pane.

Provide the name of the ARR Proxy Server in the Create Certificate wizard.

Click Next to complete creation of the certificate.

Select Default Web Site under Sites and click Bindings on the Actions pane.

Assign the certificate to HTTPS binding.

Go to the Server Farm and double click the Created Farm.
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9. Double click on Routing Rules and select the Enable SSL offloading option if you want the communication between the ARR
Proxy Servers and the WDM Management Servers to be in plain text. You also need to add both the HTTP and HTTPS ports to
the Default Web Site Bindings on the individual WDM Management Server systems.

% NOTE:

If you want the communication between the ARR Proxy Server and the WDM Management Servers also to be on the HTTPS
protocol, then you must disable the SSL off-loading feature and configure SSL on the individual WDM Management Servers. If
you use a self-signed certificate setting up SSL on the WDM Management Server, then import this certificate to the Trusted
Root Certificate Authorities store for a local computer on the ARR Proxy Server by following the steps available on Microsoft
website:_http://technet.microsoft.com/en-us/library/cc754841.aspx#BKMK_addlocal

Configuring Server Farm Properties for ARR

After the server farm has been created and defined, you need to set additional properties to manage the behavior of ARR.
To configure server farm properties:

1. Loginto the ARR Proxy Server and launch the IIS Server Manager.
2. Select the Server Farm you created. The following options are displayed on the right-hand pane:
Caching
Health Test
Load Balance
Monitoring and Management
Proxy
Routing Rules
Server Affinity
3. Select Caching.
a. De-select the Enable disk cache option to disable caching.
b. Set the Memory cache duration to O.
4. Select Health Test.

a. Enter the fully qualified domain name (FQDN) of the ARR proxy server in the URL field. The value should be : http(s)/
<ProxyFQDN>/hserver.dlI?&V93. This is the URL, which ARR uses to send requests to the WDM Management Server to
check the Health for a particular server farm.

b. Set the Interval time period after which the ARR Health Test repeats the Health Check. The default is 30 seconds. You can
set it to 180 seconds.

c. Set the time out period of the URL you specified. This is the time period during which if the server does not respond, it is
marked as Unhealthy.

d. Set the Acceptable Status codes to 200-399. If the Hhealth URL returns a status code that does not match with the
value in the Acceptable Status Codes, then ARR marks that server as unhealthy.

e. Set the text value Server Healthy in the Response Match field. The text in Response Match is verified against the
response entity from each server and if response from server does not contain the string specified in response match then
that server is marked as unhealthy.

. Click Verify URL. This should pass for all the WDM Management Servers in the server farm.

5. Change the Load Balance algorithm.

a. Select Weighted Round Robin from the Load balance algorithm drop-down list.

b. Select Even distribution from the Load distribution drop-down list.

c. Click Apply.

6. Double click the Monitoring and Management option to view the WDM Management Server health status and other statistics.
7. Double click Proxy to configure the proxy settings:

a. Change the Response buffer threshold value to O.

b. De-select the Keep Alive option.

c. Change the HTTP version to HTTP/1.1.

d. Select the Reverse rewrite host in response headers option.
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Double click Routing Rules.

Click URL Rewrite on the Actions pane.

In the Edit Inbound Rule page, set the Pattern to *hserver.dll*.

This step ensures that the ARR Proxy Server forwards only the URL requests meant for the WDM Management Server to the
Server Farm.

The Server Farm properties are now configured.

Configuring Request Filtering

To configure request filtering:

PSS

5.

Setting up Proxy FQDN in WDM Preferences

To complete the Load Balancing setup, you need to specify the Proxy server details in WDM.

Log in to the ARR Proxy Server and launch the IIS Manager.

Select Default Web Site under Sites and on the right-hand pane double click on Request Filtering.
Click Edit Feature Settings.

Set the Request Limits as shown below:

Edit Request Filtering Settings EH |

—General
¥ allow unlisted File name extensions
¥ allow unlisted werbs
W allow high-bit characters

™ sl double escaping

—Request Limits

Maximum allowed content length (Bytes):
4294967295

Maxirmum LURL length (Bytes):
40960

Maximum guery string (Bytes):
|4EIE|6EI|

[ ox |

Click OK to apply the settings.

To setup the Proxy FQDN in WDM:

Do

Log in to the system where you have installed WDM and start the WDM WEb Ul Console.
Select System — Comsole.
Under Manager Server Alias Name , enter the FQDN of ARR Proxy Server.
Click Save to save the settings.




The ARR Proxy Server is now recorded in the WDM database, and this completes the Load Balancing setup.

Installing WDM Components

The load balancing setup needs multiple installations of WDM Management Servers. However, you must make sure that one of the
systems in this setup has a complete installation of WDM. You can then install only the Management Server and the ThreadX Service
on the other systems. For more information on installing only the selected components, see Installing Management Server

Configuring Load Balancing for ThreadX 4.x Devices

When you want to manage a large number of PColP (ThreadX) devices, then a single ThreadX Manager Service may not scale up to
manage the large number of ThreadX devices. Configuring load balancing for ThreadX devices helps you to manage a large number
of such devices.

Before you configure Load Balancing for ThreadX devices, you first need to identify a Windows 2008 R2 system and install the
Domain Name Server (DNS) on the system.

For more information on installing DNS on a Windows 2008 Server, go to http://technet.microsoft.com/en-us/library/
€c725925.aspx.

The load balancing mechanism uses the DNS Round Robin method to share and distribute the network resource loads.

To set up the DNS Round Robin:

N =

SN

® N o

©

Log in to the DNS Server and launch the DNS Manager.

Select the server name on the tree in the left pane, right-click and select Properties from the menu.

The Properties window is displayed.

Click the Advanced tab on the Properties window.

In the Server Options pane, make sure that the options Enable round robin and Secure cache against pollution are checked.

If you require netmask ordering, then select the Enable netmask ordering option. This feature tries to prioritize local resources
for the clients.

Click the View menu on the DNS Manager and select the Advanced option.

Expand the Domain node and under Forward Lookup Zones, select the domain. For example, WDMSQA11.com.
Right-click and select New Host (A or AAAA)....

The New Host window is displayed.

Enter the virtual host name of the ThreadX Server Farm that will participate in the load balancing. For example,
ThreadXServer.

The FQDN of the server is displayed automatically.
Enter the IP address of the server.
Click Add Host.
Repeat steps 8-11 to add as many ThreadX Servers as you want.
Select the Domain node on DNS Manager, right-click and select Other New Records.
In the Resource Record Type dialog box, select SRV Location and click Create Record.
In the New Resource Record dialog box, enter the following values:
Service Name — _PCOIP-broker
Protocol — _tcp
Port Number — 50000.
Host Offering this Service — enter the hostname of the ThreadX Server Farm.
Repeat steps 13-15 to add the _PCOIP-tool SRV record.
Configure DNS Caching:
a. On the DNS Manager, expand the Domain node and under it select the _tep node.

:
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b. Select _PCOIP-tool on the right-hand pane, right-click and select Properties.

c. Inthe Properties window, check the Time to live (TTL) value. The caching interval is called the Maximum TTL value and
the default is 1 hour. You can change this if you want.

The TTL field is displayed only if you have selected Advanced View in the View menu of the DNS Server.

The load balancing is now configured for ThreadX devices and you can use the your WDM Management Servers to manage a large
number of ThreadX devices.

Configuring Load Balancing for ThreadX 5.x Devices

When WDM is used to manage ThreadX 5.x devices in a large enterprise environment, a single Teradici Device Proxy Server which is
used to manage ThreadX 5x devices from WDM cannot scale up to manage more than 18 thousand devices. There could be
problems or delays in client check-ins, schedule execution, and/or real-time command execution.

Load balancing helps resolve these problems to a great extent. In this setup, you can install and run multiple instances of Teradici
Device Proxy Servers on different systems and balance the load between them using a proxy as described below.

The components of the load balancer are as follows:

Teradici Device Proxy Server
HA Proxy Server

WDM uses the HAProxy hosted on the Ubuntu server 16.04.1 LTS to perform load balancing between the Teradici Device Proxy
servers. HAProxy is a load balancer proxy that can also provide HA based on how it is configured. It is a popular open source
software for TCP/HTTP Load Balancer, and proxying solution which can be run on Linux. The most common use is to improve the
performance and reliability of a server environment by distributing the workload across multiple servers.

This section describes how to set up and configure load balancing of the HA Proxy Server.
Steps to create DNS_SRV Record:

Firmware 5.x uses a DNS_SRYV record in addition to the text record that contains the thumbprint of the SSL certificate to use in the
management console.

WDM 5.7.2 supports Teradici 5.x firmware with comprehensive features.

1. The first record required is a DNS_SRV record for _pcoip-bootstrap. The record must point to the name of the Teradici Device
Proxy (HAProxy).
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Figure 38. DNS_SRV record for _pcoip-bootstrap
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2. The second record required is an A record pointing to the name used in the Host offering this service field.
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Figure 39. Host Record

3. The third record required is a Txt record. The txt record is the thumbprint of the SSL certificate in use by the management

console.
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Complete the following steps to create A record for Host as well as Txt record:

static

1. Click the domain node (delldemo.int) and select the Other New Records and then select Host (A or AAAA), the name is the A
record of the management console.
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2.
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Figure 40. Create TXT record
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Click on the domain node (delldemo.int) and select the Other New Records and then select Text (TXT), to create the text field

which has the thumbprint of the certificate.



Fully qualified domain name (FQDN):

| teme2.delldemo.int. ‘
Text:
| S A
.
{ >

Figure 41. New Resource Record

The Sha256 thumbprint can be obtained using Firefox browser.

To obtain the thumbprint when Wyse Device Manager (WDM) is installed with Teradici 5x:

1. You must open the Firefox browser from the device where Teradici 5.x component is installed. After opening the browser, press
the bring Alt + T key to open Tools.

2. From the drop-down list, select Options.
Bl Edit View Bookmarks | Tooks | Help

. : Downloads Tt

- - Add-ons  Ctri-Shift=4
&) Firefon | aboutipreferences Sign In To Sync...

Web Developer »
Page Info

Options

i

Startup
Always check if Firefox is your default browser
Firefox is not your default browser

When Firefox starts:| Show my home page

Home Page:| Mozilla Firefox Start Pag

"

Figure 42. General Tab

3. Inthe left pane of the Options page, click Advanced tab and then click Certificates option.
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Figure 43. Advanced

Click View Certificates to open the Certificate Manager window.
Select the Authorities tab on the Certificate Manager window and click Import.
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Certificate Manager

Your Certificatesl P'El:uplelﬂer-.rers | Authorities | Others|

You have certificates on file that identify these certificate authorities:

Certificate Mame Security Device B3
aAC Camerfirma 5.4, -
Chambers of Commerce Root - 2008 Builtin Object Token
Glebal Chambersign Root - 2008 Builtin Object Token
AAC Camerfirma SA CIF A82743287
Chambers of Commerce Root Builtin Object Token
Global Chambersign Root Builtin Object Token
aACCY
ACCVRAIZY Builtin Object Token
4 Actalis 5.p.A./03358520067 w
Yiew... Edit Trust... Import... Export... Delete or Distrust...
oK

Figure 44. Certificate Manager

6.  Inthe file browser dialog navigate to the location where WDM is installed, For example: \Wyse\WDM\TeraDici, where the root
path can be C:\Program Files (x86) based on the operating system and installation path.

NOTE: In some cases if the Teradici components are installed in a custom manner or manually configured, the above

steps must be followed on the same device, and the standard installer path may not be applicable. In such case

navigate to corresponding root path where Teradici folder is available.

7. Select the file with the name cert.pem and then click Open.

Now click the View button in the Downloading Certificate window.
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9.
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You have been asked to trust a new Certificate Autheority (CA).

Do you want to trust “localhost” for the following purposes?
[] Trust this CA to identify websites.

[] Trust this CA to identify email users.

[] Trust this CA to identify software developers.

Before trusting this CA for any purpose, you should examine its certificate and its policy and
procedures (if available).

Wiew Examine CA certificate

Figure 45. Downloading Certificate

Copy the sha256 fingerprint value. Click Close and cancel all the firefox windows.




General | Details

Could not verify this certificate because the issuer is unknown.

Issued To

Common Marme (CM) localhost

Organization (O] EMSDE

Organizatienal Unit (OU) EMSDEDEMO

Senal Mumber 00:80:D1:DD:90:4D:23:FF:84

Issued By

Common Mame (CH) localhost

Organization (O) EMASDIE

Organizational Unit (OU) EMSDKDEMO

Period of Validity

Begins On Monday, Mevember 14, 2016
Expires On Friday, January 31, 2025
Fingerprints

SHA-256 Fingerprint
87:C1:50:31:1B:34:"

SHAT Fingerprint 38:2%:7C:35: D3 F% D04 EE:EA: D2 TR FO:0C: 5A:1 2: DA 03:F2:ED

Figure 46. Certificate Viewer

NOTE: In the Text field the text must be prefixed with pcoip-bootstrap-cert= to the sha256 fingerprint which is

obtained already.
After copying the certificate fingerprint, complete the following stepson the DNS server:
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Text (TXT) | Securty

Record name (uses parent domain if left blank):

|tc:mc2 ‘
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Figure 47. tcmc2 Properties
10. The fourth and final record is a reverse PTR record for the management host.
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Figure 48. PTR Record

1. The zone must match the subnet that the host is in, and the record is the IP address assigned to the Teradici Device Proxy
(HAProxy).

Installing and configuring HAProxy

HAProxy which is the load balancer for ThreadX 5x devices is configured on Ubuntu Linux version 16.04.1 with HAproxy version 1.6.
Follow the steps to install and configure HAproxy on Ubuntu Linux machine:

Reference link: https://haproxy.debian.net/# ?distribution=Ubuntu&release=precise&version=1.6

1. Log in to Ubuntu machine by providing the user credentials used during the installation of Ubuntu operating system.
2. Open the terminal and execute the following commands to install HAProxy:

sudo apt-get install software-properties-common
sudo add-apt-repository ppa:vbernat/haproxy-1.6
sudo apt-get update

sudo apt-get install haproxy

.
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3. Execute the following commands to configure HAProxy:

Back up original configuration before editing, with the command sudo cp /etc/haproxy/haproxy.cfg /etc/haproxy/
haproxy.cfg.original

Now edit the configuration file with the command sudo nano /etc/haproxy/haproxy.cfg
In the configuration file edit the following sections as per the requirement:

— Global section: Maxconn <maximum number of connections>

— Frontend tcp-in: bind <HAProxy server IP>:5172

— Back end servers: server <server alias name> <Teradici Device Proxy server |P>:5172
— maxconn <maximum number of connections per Teradici Device Proxy server>

% NOTE: For achieving high availability, administrator may add additional back end servers beyond the total
number of clients capacity to have seamless fail over.

After editing the configuration, save it with command Ctrl + O
The sample HAProxy configuration is provided as follows:

global

log /dev/log local0

log /dev/log locall notice

chroot /var/lib/haproxy

daemon

#maxconn is maximum allowed connections
maxconn 50000

defaults

log global

mode tcp

timeout connect 5000ms

timeout client 50000ms

timeout server 50000ms

errorfile 400 /etc/haproxy/errors/400.http
errorfile 403 /etc/haproxy/errors/403.http
errorfile 408 /etc/haproxy/errors/408.http
errorfile 500 /etc/haproxy/errors/500.http
errorfile 502 /etc/haproxy/errors/502.http
errorfile 503 /etc/haproxy/errors/503.http
errorfile 504 /etc/haproxy/errors/504.http
frontend tcp-in

#replace IP with IP of your Linux proxy machine

87



bind 10.150.99.102:5172

default_backend servers

backend servers

#Add your multiple back end windows machine IP with 5172 as port

# maxconn represents number of connection- replace 10 with limit #(below 20000)
# server1 server2 are just names and not keywords

server serverl 10.150.99.107:5172 maxconn 10

server server2 10.150.99.107:5172 maxconn 10

Now validate the HAProxy configuration file with the command sudo haproxy —f /etc/haproxy/haproxy.cfg —c.
If configuration is valid the following message will be shown:

Configuration file is valid

Now restart HAProxy service by using the following command:

Sudo service haproxy restart

Command to stop the HAProxy service

Sudo service haproxy stop

Command to verify the version of HAProxy

Sudo haproxy —f

Command to uninstall HAProxy
Sudo apt-get remove haproxy
or

Sudo apt-get purge —auto-remove haproxy

Installing Teradici Device Proxy Servers

Teradici Device Proxy servers can be installed on the servers which run the following operating systems:

Windows 2012
Windows 2012 R2
Windows 2008 R2 x64bit

Follow the steps provided to install Teradici Device Proxy service:

S NI SR
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Log in to the system as administrator.

Copy the WDM installer folder to the target machine.

Go to TeradiciDeviceProxy folder.

Double click the WDMTeradiciDeviceProxy.exe file to install the same.
Provide the following inputs:

a.  Select the path where you want to install Teradici Device Proxy and its dependent components.
b.  Select Cert.pem file from the folder <WDM installed location>\Teradici on the machine where ThreadX 56X component

is selected while installing WDM.



C

Select emsdk.keystore file from the folder <WDM installed location>\Teradici\EMSDK\config on the machine where
ThreadX 5X component is selected while installing WDM.

WDM Teradici Device Proxy - InstallShield Wizard

Teradici Device Proxy Installation Details

Select installation directary for this utility | | | BROWSE..
Certficate File (cert.perm) | |
EMSDEK Keystore File (emsdickeystore) [ | BROWSE...

NEXT
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6.

7.
8.
9.

10.

Provide the required inputs and click Next.

Successfully installed WDM Teradici Device Proxy

Completed installation

Click Finish.

The install log will be created at <EMSDK Installed location>\Teradici\Detail_TeradiciDeviceProxy.log.
Click the Start menu — Administrative tools — Services.

Verify ThreadX 5x Manager Windows Service is installed and running.

Adding Teradici Device Proxy Servers to WDM

Follow the steps provided to add Teradici Device Proxy Servers to WDM:

N

Open WDM Web Ul and log in as administrator.
Go to System — console and enable Teradici Device Proxy servers option.
Click Add Server.

Add the Teradici Device Proxy server name in the server name field and give port number of the Teradici Device Proxy service
in the port number field. The default value is 49159.

% NOTE: If the default port number is changed, it must be updated in WDM. Please refer the WDM 5.7.2 Admin guide.
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5. Click on the Check Mark on the right hand side of the text boxes to save the values.

Adding HAProxy to WDM
Follow the steps provided to add HAProxy to WDM:

Log in to WDM Web Ul as administrator.

Go to console page and enable HAProxy Server option.

Click Add Server.

Add the HAProxy Server name in the server name field and give port number as 5172.

NN
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5. Click Add Server again.
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6.  Click on the check mark on the right hand side of the text boxes to save the values.

Restarting Threadx API

Follow the steps provided to restart Threadx API:

Log in to the server where WDM ThreadX 5x component is installed.

Click the Start menu — Administrative tools — Internet information service (lIS) manager..
Expand the root node (host name of the server) and select Application pools — ASP .Net v4.0.
Right click ASP .Net v4.0 and select Stop.

Again right click ASP .Net v4.0 and select Start.

Open WDM web Ul and login as administrator.

N O o s N

Verify the status using the dashboard.

Verify status from Dash board

1. Click on dash board and Select Teradici Servers.
2. Verify that Thread5x, Teradici HAproxy and Teradici Device proxy server status are Online.

®



Dell Wyse Device Manager

Duashbaard Device Health Jakss —
O Davieas
[ Appications
b Updates ¢ D
Ail Reparts Sywtem is haalthy Tatal ot
= bem
(LU TEa b =5
@ wos senvers o
Terad o Desioe Prooy Sener
-. Discosury o imaging
WORALIPa
@ scheducr i
Last Check i 23-00-1n ¥ 18:34:
@ MAsTER Repastery IP At
1015022555
.- Terad Semmm 3
Ligtering Port
13159
Hi Proiy Senser
10150117.208
alin
1P Bkl i Listering Fom B
PLIELN T 20 a2
W
Figure 49. Status on Dashboard
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Figure 50. Status on Dashboard
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Manual installation of WDM database using scripts

This section contains database scripts supported by Wyse Device Manager (WDM) and related functionality details.

Requirements
Existing WDM database support

WDM installation supports SQL Server 2008. The database contains all the SQL server objects such as tables, views, stored
procedures, and so on. The WDM installer stores the database to the respective folder (default is: C:\Program Files (x86)\Wyse
\WDMN\Database) and attaches the same to server machine where WDM needs to be install.

Then the installer updates the server details, user details, Software Repository configuration details, and so on to the server machine.

Proposed way of installing WDM database
Provided scripts are used to install WDM database version 5.7.

Prerequisites—Before executing the scripts, the database path folder must be created and firewall must be disabled in the database
server.

% NOTE: The following scripts must be executed in the same order as they are mentioned. If not, you have to delete the
database and repeat the entire process again.

Script files

The following database script files will be used to install database of WDM 5.7:

CreateDatabase.sql
Schema&User.sql
Tables.sql
Userdefinedtables.sql
Views.sql
Stored_Procedures.sql
Default_Table_Data.sql
CustomizeScript.sql

CreateDatabase.sql

To create the database manually, execute the following script:
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% NOTE: The database scripts are mentioned here for customization purpose.

CREATE DATABASE [RapportDB]
ON PRIMARY

(NAME = N'Rapport dat', FILENAME = N'C:\Program Files (x86) \Wyse\WDM\Database\Rapport4.MDF,
SIZE = 42496KB, MAXSIZE = UNLIMITED, FILEGROWTH = 10%)

LOG ON

(NAME = N'Rapport log', FILENAME = N'C:\Program Files (x86) \Wyse\WDM\Database
\Rapport4.LDF', SIZE = 768KB, MAXSIZE = UNLIMITED, FILEGROWTH = 10%)

GO
1. The script file contains RapportDB Database creating scripts.
2. User or Administrator can change the file path. Default file path is C:\Program Files (x86)\Wyse\WDM\Database.

% NOTE: Check the above mentioned folder to verify the step. This folder should contain Rapport4.mdf and
Rapport4.df.

Schema&User.sql

To create a user account execute the script. You can add and assign permission to any user account.

1. The script file contains the details about creating schema and User role.

2. The default values are rapport schema and rapport user. If you want to change the WDM access user, you can change from
here.

Tables.sql

This script file contains script for all table objects and constraints.
% NOTE: Custom changes are not included in this file.
Userdefinedtables.sql

This script file contains script for all the User Defined Table objects.
% NOTE: Custom changes are not included in this file.
Views.sql

This script file contains script for all View objects.

% NOTE: Custom changes are not included in this file.
Stored_Procedures.sql

This script file contains script for all Stored Procedure objects.
% NOTE: Custom changes are not included in this file.
Default_Table_Data.sql

This script file contains script for all Default Table Data values such as, OS, Platform, Management Type, Default Groups, Default
Software Packages, Default Parm details, and so on.

% NOTE: Custom changes are not included in this file.

CustomizeScript.sql
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This script file contains script for Customize Data values.

Provide the database server name while executing the following script. An error is displayed, if you do not enter the server name.

g NOTE:

---- Customize Script

Use RapportDB

Go

SET IDENTITY INSERT [dbo] . [License] ON

INSERT [dbo].[License]

([LicenseID], [Sales], [UnActivated], [Code], [License], [Utilize], [NumberOfClients],
[VendorID])

VALUES

(1, N'7V931PHYO8KO1LZHYXWKKP6GQ1l', N'BR69T51SSP500PFWOW4R0Z0TL5', NULL, NULL, NULL, NULL,
NULL)

SET IDENTITY INSERT [dbo] . [License] OFF

GO

SET IDENTITY_INSERT [dbo] . [sysHash] ON

INSERT [dbo].[sysHash] ([ID], [Hash]) VALUES (2,
0x4458473935334D31513034525254524643475338343442485836)

SET IDENTITY INSERT [dbo] . [sysHash] OFF

Go

Begin

Declare @DBServerName varchar (200) =
Set @DBServerName = ''

If (@DBServerName is null or @DBServerName = '')

Begin

RAISERROR (N'Database Server Name Should not be Empty...', 16, 1)

End

Else

Begin

SET IDENTITY INSERT [dbo].[Install] ON

INSERT [dbo].[Install]

([InstallID], [Module], [ServerName], [UserName], [Installed], [Status], [Information],
[RegKey], [RegName], [RegValue], [LatestHFID], [SiteID], [SiteName])

VALUES

(0, N'Rapport4DB', @DBServerName, N'administrator', GetDate(), N'MASTER', NULL, NULL, NULL,
NULL, N'OOHF05070001516', 0, NULL)

SET IDENTITY INSERT [dbo].[Install] OFF

End

End

Go

Upgrading WDM using database scripts

To upgrade from WDM 5.7 to WDM 5.7.2, do the following:

1. Extract the contents of the WDM installer on the system where you want to install WDM.
2. Navigate to the folder where you have extracted the installer and go to WDMvb.7.2_GA\SQL path.
3. Execute the scripts in the following order:

CommonTables.txt
CommonStoredProcs.txt
Tables.txt

StoredProcs.txt

:
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Troubleshooting

This section describes how to troubleshoot the issues that you may encounter while installing or upgrading WDM.

.NET Framework Installation Error in Windows 2012
Issue: .NET Framework 3.5 installation fails on Windows Server 2012 with error code 0x800F0906
Resolution:

Method 1:

1. Log in to the system where you have installed Windows Server 2012 and launch the Server Manager.
2. Install .NET Framework 3.5 features using the Add Roles and Features wizard in Server Manager.

3. While installing specify an alternate source path using the link at the bottom of the wizard.
Method 2:
Using DISM from the command prompt, specify the source files path parameter:

For example, if D: is the Windows Sever DVD media, the source files path would be: DISM /Online /Enable-Feature /
FeatureName:NetFx3ServerFeatures /FeatureName:NetFx3 /Source:D:\Sources\sxs

Method 3:

1. Log in to the system where you have installed Windows Server 2012 and launch the Server Manager.

2. Install Server Role Windows Server Update Services (WSUS)using Add Roles and Features Wizard in Server Manager.

3. Using DISM from the command prompt, specify the source files path parameter: DISM /Online /Enable-Feature /
FeatureName:NetFx3ServerFeatures /FeatureName:NetFx3

4.  Make sure Windows Update Service is running, and Windows Update store can be connected from where the necessary

components can be retrieved.

Failure While Attaching the Database

Issue: Failure while attaching the database on Windows 2012 Server, with SQL Server 2012.

Resolution:
Run SQL Service ‘MSSQLSERVER'’ using the ‘LocalSystem’ account on the system where WDM installation is targeted.

Retry WDM installation.



Error While Installing WDM Database in a Distributed Setup

Issue: When you are installing the WDM Database on a separate system that has the supported version of SQL Server installed on it,
then the following error may be displayed when you launch the Setup.exe : Setup was unable to initialize the required libraries.

Resolution: Make sure that the Microsoft Visual C++ Redistributable 2008, version 9.0.21022 is installed. You need to navigate to
Start — Control Panel — Programs to view if the redistributable is installed. If it is not installed, then you must manually install it by
running the veredist_x86.exe available under the Prereq folder of the WDM Installer.

Database Installation Failure After Manual Uninstallation of SQL Server
Express 2014

Issue: The WDM database installation fails after you manually uninstall the existing SQL Server Express 2014, and use the Install
New Database option in the installer.

Resolution: To resolve this issue:

N

Uninstall SQL Server Express 2014 R2 from Add\Remove Programs.

2. Launch the Services window from Control Panel — Administrative Tools.

3. Delete the MSSQL$RapportDb Service

4. Delete MSSQL12.RAPPORTDB from the SQL Server Express Installation folder.

5. Delete the RapportDB registry entry from HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL Server
\Instance Names\SQL.

6. Delete the MSSQL10_50.RAPPORTDB registry entry from HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft
SQL Server.
Delete the RAPPORTDB registry entry from HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL Server.

8.  Restart the WDM Installer.

After Upgrading from WDM 5.5.1 to WDM 5.7 Software Repository is
not Secure

Issue : If WEB Ul is selected during Upgrade, then Management server will be configured to Https, But WDM Software repository
will not be configured by the installer.

Resolution : Manually Set the Software repository to HTTPs in the WDM GUI. To set manually, go to Configuration Manager
Software Repository.

Troubleshooting Post Deployment

Issue : HT TP Error 404.0 — Not Found. the Web.config of the HApi shall be added with a url routing module if it's missing:
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Resolution :Add the Web.config of the HApi with a URL routing module as follows:

<system.webserver>

<modules>

<remove name= "urlroutingmodule-4.0"/>

<add name= "urlroutingmodule-4.0" type="system.web.Routing.urlroutingmodule"
precondition="" />

</modules>

Troubleshooting Load Balancing Issues

This section describes how to troubleshoot some issues that you may encounter in the Load Balancing setup.

Health Test Feature in ARR Proxy (with SSL) Fails with Error Code 80072F8F

Issue: If the ARR Proxy does not trust the backend server’s Digital Certificate, the health test may fail with the Error Code
80072F8F.

erify URL Test =
Resulte:
Server Address Result Dretaals
Serverd Fail Cannot connect Lo the server. The HTTP status code i5 0 and the emor code is B00T2FEF,
Close

Resolution: Import the certificate that is used to setup SSL on the WDM management server onto the Trusted Root Certificate
Authorities store for a local computer on the ARR Proxy system by referring to http://technet.microsoft.com/en-us/library/
cc/54841.aspx#BKMK_addlocal.

ARR Proxy Returns HTTP Error Code 502.3

Issue: The ARR Proxy returns the HT TP Error Code 502.3 for older WDM Agents (HAgents) that do not send the
HTTPHEADSUPP=2 tag when they are checking in. If the HAgent does not send the HTTPHEADSUPP=2 tag while checking in,
then the Management Server does not send the HTTP status code header (200 OK) in response and the ARR proxy returns the
error. Only the clients sending the value 2 are supported in load balancer setup.

Resolution: You can run the following query on the WDM Database and read the value:

SELECT [HttpHeadSupp]
FROM [ClientNetwork]
where [MAC] = <ClientMac>
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ARR Proxy Returns HTTP Error Code 502.4

Issue: The ARR Proxy server could return the HTTP Error Code 502.4 when any of the Management Servers (HServers) are not
available. The Health Status of all the HServers in the Server Farm may be set to Unhealthy because the configured Health Tests
have failed.

Resolution: To correct this:

RN

Log in to the ARR Proxy Server and launch the IIS Server Manager.
Select the Server Farm you created and on the right-hand pane, select Monitoring and Management.

Select the HServers and in the Action pane, select Set Server as Healthy.

ENISNIEN

If the load on the HServer is high then try to increase the interval and time-out values in the Health Test feature

Enabling SSL Offloading on Proxy

Load Balancing is only supported in HTTPS setup. For debugging, if you want to see the Management Server (HServer) response in
Wireshark capture, then you can change the HServer-Proxy communication to HTTP.

[N

Log in to the ARR Proxy Server and launch the IIS Manager.

N

Double click the Routing Rules feature and select Enable SSL offloading setting.

<

Enable both HTTP and HTTPS binding in the website on the HServer machines and do not select Require SSL in the SSL
Settings.

Indefinite Preceding during Installation

Issue: Installation proceeds indefinitely while installing Microsoft Visual C++ Redistributables or Microsoft SQL Express 2008. The
OS Supported are Windows 2012 Standard and Windows 2012 R2.

Resolution: Open the Task Manager, and check whether the ‘Windows Modules Installer Worker' process is running on your thin
client or not. If this process is running, you must end the process for installation to resume. Restart the thin-client after the
installation is complete.

Load Balancer Issue

Issue: Proxy Server does not respond if the IP V6 Address is enabled.

Resolution: Disable the IP V6 Address of the Load Balancer Setup.

Upgrading WDM on Windows 2008 SP2 32 bit
Issue: To upgrade WDM 5.7 on Windows 2008 SP2 32 bit, enable the Windows Update service.

Resolution: To upgrade WDM 5.7 on Windows 2008 SP2 32 bit, enable the Windows Update service to install the Hotfix KB980368.
After the installation of Hotfix KB980368, disable the Windows Update Service to install the WDM 5.7.
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WDM Upgrade Installation Fails

Problem: WDM Upgrade installation fails while connecting to software repository.

Resolution: One of the reason for this issue is, the Computername for the setup has more than 16 characters. This brings out a
mismatch in Computername and NetBIOS name (truncated to 15 chars) for the setup. To confirm this issue, check if the above
mentioned system variables are different. If yes, install WDM on a setup which has hostname to a max of 15 characters, and then re-
run upgrade installer.

Configuration Error After Upgrading from WDM 5.7 to WDM 5.7.2

Issue: After you install WDM successfully and reboot the system, the following services are configured to run under dedicated
account, but do not start due to a logon failure. Such as,

ThreadX Manager
Recurring Schedule
HServerlnit

WDM DHCP Proxy

Reason: Installer failed to provide 'Log On As A Service' right to the user account.

Resolution: Manually configure the user account to have 'Log On As A Service' permission.

Cloud Environment Setup Issue

Issue: An error message is displayed intermittently when you run the setup . exe file during WDM installation in the cloud
environment.

Resolution
Scenario 1- Only the error message is displayed

Close the dialog box displaying the error message, and then run the setup . exe file again.

Scenario 2- An error message is displayed along with the Welcome Screen running in background

Close the dialog box displaying the error message and the Welcome screen, and then run the setup . exe file again.

Error in Installation of WDM in Upgrade Setup

Issue: During the installation of WDM, if you use different database user other than the default user, then you will not be able to
proceed with the installation of WDM in Upgrade setup. Unable to proceed with the installation, aborting installation error
message is displayed.

Solution:

Open WDM GUI.

Right click Configuration Manager and select Utilities — Database Credential Manager.
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A warning message is displayed. Click OK.
Enter the user name and password of the user used when you installed WDM. Click Ok to continue.

Now close the WDM GUI and proceed with the installation.

After installation, run the Database Credential Manager available in the Install path (C: \Program Files (X86) \Wyse\WDM
\Utilities\Database) again.

Provide your username and password used when you installed WDM, and then reboot the server.
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